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About this document 
This guide describes IT-managed installations to platforms running on the following environments1: 

• Microsoft Windows directly 

• Citrix 2, specifically: 

• Windows application virtualization with Citrix Virtual Apps (formerly XenApp) (published app or published desktop) 

• Windows desktop OS virtualization with Citrix Virtual Desktop (formerly XenDesktop) 

• VMware3, specifically: 

• Horizon 8 Connection Server, Agent, and Client 

• Blast display protocol 

This document also details the steps and any post-installation configuration and customization that is required to install the 
application.   

A summary of all changes made in this document can also be found in the Version History. 

Intended readership 
The LSEG Workspace Installation and Configuration Guide is intended for IT specialists that are responsible for the installation and 
maintenance of Workspace and Messenger standalone.  

Software releases and end of life 
Refer to the Workspace Support Policy, which can be found in the documentation section of the LSEG Workspace page.  

In this guide 
The following text styles are used to provide important and additional information: 

⚠ Text Bold text, preceded with the red warning sign is used to indicate highly important or critical information. 

Footnotes31 Footnotes are used to provide additional information and are indicated with hyperlinked, superscript numbers 
attached to the keyword in a sentence to which they relate. When clicked, you are taken to the related information, 
at the bottom of the same page. 

Further information 
To:  

• Request product assistance, contact Support. 

• Access other LSEG Workspace technical content, see the Workspace technical documentation site. 

• Provide feedback on Workspace technical content, contact DocFeedback@lseg.com.  

 
 
1  Instructions for macOS installation are provided in the Workspace Basic Installation Guide. 
2  LSEG currently provides limited testing support and technical advice on Citrix Virtual Apps and Desktops (CVAD) solutions. However, 

customers deploying a CVAD solution should consider the following when deploying, updating, and running Workspace:  

• The impact of network latency and equipment used.  
• The potential for virtualization machines to adversely affect performance for end users.  
• Legacy products such as Eikon will not work in parallel with Workspace 

3  As summarized for Citrix, above, LSEG currently provides limited testing support for VMware and the same considerations should be applied 
when deploying. 

https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/support-policy.pdf
https://www.lseg.com/en/data-analytics/products/workspace#documentation
https://www.lseg.com/en/contact-us
https://www.lseg.com/en/data-analytics/products/workspace#documentation
mailto:DocFeedback@lseg.com
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/basic-installation-guide.pdf
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Pre-requisites 
This section summarizes the information of which you should be aware prior to commencing the installation of Workspace. 

In this section 
• Verifying system requirements 

• Virtualized environments 

Verifying system requirements  
Before installing Workspace, ensure that your hardware and software meet the minimum requirements.  

LSEG recommends the following:  

• Create a Workspace test user ID to validate the installation. For further assistance, contact your account team or Customer 
Success Manager. 

• 3D Graphics Processing Unit (GPU) acceleration is enabled. Workspace is based on Chromium, which uses the GPU for 
rendering environments. 

System and network testing  
The System Test4 application helps you determine whether your computer meets the minimum hardware, software, and 
connectivity requirements to run Workspace. No personal information is sent to LSEG during this process.  

For further information regarding the System Test applications, refer to the System Test Guide.  

Virtualized environments 
When designing a deployed solution, individual utilization should be considered in the planning. If specific information is required, it 
is recommended that a selection of pilot users is monitored so benchmark testing can be performed by the relevant vendor support 
team.  

⚠ If you encounter an issue when running Workspace in a virtualized environment, LSEG cannot investigate or escalate unless 
the issue is reproducible on a standalone desktop, running Workspace in a non-virtualized, single instance environment. 

VDI support 
Support is included with your subscription, when Workspace is installed according to our system requirements on a standalone 
desktop PC for one user.  

Due to the inherently complex and distributed nature of these solutions, we cannot offer the same unconditional support as a 
standard desktop for the following: 

• Terminal/Citrix Server  

• VMware Server  

• Other multi-user or virtualized environments  

Help with installing and/or operating our software in these environments is strictly limited to a commercially reasonable effort. While 
this document makes every attempt to highlight the issues you may encounter, we can make no guarantees regarding a successful 
outcome.  

 
 
4  In currently supported versions of Workspace, the test performed prior to installation no longer checks for the presence of the PowerShell app, 

as the 50 most used apps do not require this application. However, if you are using more niche applications, it may be a requirement.  

https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/system-requirements.pdf
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/system-test-guide.pdf
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Installing Workspace 
Workspace can be installed on Windows, as a User or Machine Installation, and deployed to CVAD.  

However, it is recognized that there is much innovation and change in our marketplace. As such, the content of this document is 
updated, as warranted by future changes in the marketplace, and the evolving needs of our software products. 

In this section 
• PC installation 

• Citrix installation 

• VMware installation 

• Running Workspace for Web 

• Post installation testing 

PC installation 
This section discusses the installation of Workspace onto personal computers. 

⚠ Workspace installers require administrator rights to create their own registry path entries. 

Installation method summary table 
Detailed information about command line statements is provided in Appendix C. 

Parameter Installation5 
location 

Launch/Update 
location 

Automatic update Windows service 
required 

--user %LocalAppData% Yes No 

--machine-autoupdate-service %ProgramFiles% %ProgramData% Yes Yes 

--machine-autoupdate-no %ProgramFiles% %ProgramData% No No 

--machine-autoupdate-peruser 6 %ProgramFiles% %LocalAppData% 7 Launch / Update 
location only 

No 

 

Workspace Help parameter options 
When installing Workspace, you can use the --help parameter to list all parameters that are available.  

The Command Prompt also lists all error codes that could be displayed during a Workspace installation. These codes are listed in 
the Error codes section. 

Command line statements have the following structure, where one or more <option> parameters are non-mandatory:  

RefinitivWorkspace-installer_x.xx.xx.exe <operation> <option>  

For a full list of parameters, refer to the Installer parameters section. 

 

 
 
5  Default locations. These are customizable during installation. 
6  See Important note in Uninstalling Workspace. 
7  A copy of the Installation (master image) will be created for each user when they first log into the machine. If the version of the master image 

changes, the local version is refreshed when a user next logs in. 
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Customizing paths 
During the installation, you have the option of determining your own path for installation files, logs, cache files, and shortcuts. To do 
this, use one of the following commands: 

Action Command 

Change install location RefinitivWorkspace-installer_x.xx.xx.exe --installpath="<folder_path>" 

Change log location  RefinitivWorkspace-installer_x.xx.xx.exe --logpath="<folder_path>" 

Change cache location8 RefinitivWorkspace-installer_x.xx.xx.exe --cachepath="<folder_path>" 

Change icon shortcut location RefinitivWorkspace-installer_x.xx.xx.exe --shortcuts="<folder_path>" 

Change installer log path RefinitivWorkspace-installer_x.xx.xx.exe --installerlogpath="<folder_path>" 

 

You can use multiple parameters in one command line. For example:  

RefinitivWorkspace-installer_x.xx.xx.exe --installpath="<folder path>" -–cachepath="<folder_path>"  

Performing a User installation 
When you perform a user installation, files are created in the %LocalAppData%\Refinitiv\Refinitiv Workspace\ folder. 

To install Workspace on a user basis: 

1. Download the Workspace package.  

2. Run the .exe file or use the Workspace command lines using the command prompt app. In a user installation, administrator 

rights are not required9. 

3. Follow the on-screen instructions to install Workspace10:  

Performing a Machine installation 
Note that to perform any per machine installation, you require administrator access rights. 

With the auto-update Windows service 

This is the recommended installation mode and is the preferred method for your organization, where: 

• Users are not allowed to run programs from areas where they have no write permissions on %ProgramFiles%.  

• Applications are reviewed before being approved across your organization, to ensure that they do not undermine application 
whitelisting. This is especially important for scripting languages, which have their own execution environment.  

 
 
8  See Cache path definition in the Known issues section. 
9  To review help for the RefinitivWorkspace-installer_x.xx.xx.exe command, add the parameter –-help. 
10  For further details, see the Workspace Basic Installation Guide. 

https://www.lseg.com/en/data-analytics/products/workspace/download-workspace
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/basic-installation-guide.pdf
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For this installation, files are created in the following folder: 

Type of OS Installation Path 

Windows    Default %ProgramFiles%\Refinitiv\Refinitiv Workspace\   

 

To install Workspace on a machine basis:  

1. Download the Workspace package 

2. Do either of the following: 

a) Run the executable, taking the Install for all users on this computer 
option11  

Or 

a) Click Start > Windows System > Command Prompt  

b) Run RefinitivWorkspace-installer_x.xx.xx.exe --machine-
autoupdate-service --sharedconfig="<file path>" 15 

With auto-update per user  

 This installation mode 
12 is the preferred method for your organization, where: 

• Users are not allowed to run programs from areas where they have no 
write permissions on %ProgramFiles%.  

• Applications are reviewed before being approved across your organization, to ensure that they do not undermine application 
whitelisting. This is especially important for scripting languages, which have their own execution environment.  

For this installation, files are created in the following folders: 

Type of OS Installation Path 

Windows    

Master image  %ProgramFiles%\Refinitiv\Refinitiv Workspace\   

Copy 13 14 %LocalAppData%\Refinitiv\Refinitiv Workspace\ 

 

⚠ The master image must be updated on a regular basis, in accordance with the Support Policy, to avoid the situation where a 
new user on a machine can install a version of Workspace into their profile that is no longer supported.  

To install Workspace on a machine basis: 

1. Download the Workspace package 

2. Click Start > Windows System > Command Prompt 

3. Run RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-peruser --sharedconfig="<file 
path>" 15 

Without auto-updates 

This installation mode is the preferred method for organization running hot-desking, gold images, non-Persistent VDIs, or 
Provisioning Services (PVS) with configuration to clear changes once user close their Windows sessions. 

For this installation, files are created in the following folder: 

Type of OS Installation Path 

Windows    Default %ProgramFiles%\Refinitiv\Refinitiv Workspace\   

 
 

 
11  For further information, see the Workspace Basic Installation Guide. 
12  See Important note in Uninstalling Workspace. 
13  Copy installation location. 
14  Once the master image has been copied to the profile of the user, the user needs to restart their machine. 
15  Defining a shared configuration file (or files, for failover purposes) is optional but strongly recommended for mass configuration. 

https://www.lseg.com/en/data-analytics/products/workspace/download-workspace
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/support-policy.pdf
https://www.lseg.com/en/data-analytics/products/workspace/download-workspace
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/basic-installation-guide.pdf
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To install Workspace without auto-updates: 

1. Download the Workspace package 

2. Click Start > Windows System > Command Prompt 

3. Run RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-no --sharedconfig="<file path>" 15 

Performing an installation using your Single Sign On URL 
Defining a shared configuration file (or files, for failover purposes) is optional but strongly recommended for mass configuration. 

Using the command line 

To install Workspace using your Single Sign On (SSO) URL16, do the following: 

1. Download the Workspace package 

2. Click Start > Windows System > Command Prompt 

3. Add the appropriate parameter from the table below17, depending on your environment: 

Environment Additional installation parameters Settings location 

User --client-sso=<client SSO URL> user-settings.json  

Machine  --client-sso=<client SSO URL> machine-settings.json 

Citrix installation 
This section addresses the currently supported scenarios for Workspace deployment to CVAD. However, it is also recognized that 
there is much innovation and change in our marketplace. As such, the content is updated, as warranted by future changes in the 
marketplace, and the evolving needs of our software products.  

Installing Workspace for Citrix XenApp 
1. Check that no previous Eikon registry keys are set. 

2. Ensure that the following registry keys are applied, to disable Citrix API hooks for a single executable file18: 

Version CVAD 7 
1912 LTSR 

XenApp 7.6 LTSR XenApp 7.15 LTSR 19 

Key(s) 
No 

modification 
to registry 

keys is 
required 

HKLM\SOFTWARE\Citrix\CtxHook 
HKLM\SOFTWARE\Wow6432Node\Citrix\CtxHook 

HKLM\SYSTEM\CurrentControlSet\servic
es\CtxUvi 

Value name ExcludedImageNames UviProcessExcludes 

Type REG_SZ REG_SZ 

Value to add20 RefinitivWorkspace.exe 21 RefinitivWorkspace.exe 
 

3. To show the Workspace context menu when right-clicking the Windows taskbar, refer to the Citrix Support Knowledge Center 
article CTX131995, User Cannot Launch Application in Seamless Mode in a Provisioning Services Server when XenApp 
Optimization Best Practices are Applied. 

4. On the Citrix server, to change to installation mode, use the command line: 

Change user /install  

 
 
16  You can also configure your SSO for authenticating into Workspace for Web. See Configuring Single Sign On (SSO) for Workspace Web. 
17  This parameter should be added to the installer executable, also in combination with additional parameters. 
18  For further information, see https:\\support.citrix.com\article\CTX107825. 
19  Reboot from the VDA required. 
20  Process names have a 14-character limit. For example, to exclude longappname.exe, you add longappname.ex. 
21  If you want to use the Session Sharing Chrome Extension, add Refinitiv-host.exe. 

https://www.lseg.com/en/data-analytics/products/workspace/download-workspace
https://www.lseg.com/en/data-analytics/products/workspace/download-workspace
https://support.citrix.com/article/CTX131995
https://support.citrix.com/article/CTX131995
https://support.citrix.com/article/CTX107825
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5. To install Workspace, use the following command line, which includes the log and cache paths22, which must point to the same 
location from where RefinitivWorkspace.exe is run: 

RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-no --logpath="<folder_path>" --
cachepath="<folder_path>" 

⚠ For mass deployment, it is recommended that you define a shared configuration file (or files, for failover purposes23).  

6. Once the installation has finished, change back to execute mode, using the command line: 

Change user /execute  

Publishing Workspace applications for XenApp 
To complete the installation, you must publish both Workspace and Refinitiv Workspace - Excel applications in Citrix XenApp. 

To do this, use your usual configuration software, whether Citrix or third party, with the following parameter settings:  

Product Parameter Setting 

Workspace 

Path to the executable file <installation_path>\RefinitivWorkspace.exe 

Working directory <installation_path> 

Workspace for 
Excel 

Path to the executable file <installation_path>\RefinitivWorkspace.exe 

Command line argument --excel 

Working directory <installation_path> 

Installing Workspace for Citrix XenDesktop 
If you use gold images, non-Persistent VDIs, or Provisioning Services (PVS) with configuration to clear changes after the user 
closes a session, you must install Workspace in without auto-updates mode using the following argument: 

RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-no --sharedconfig="<file path>" 

In most cases, the Per-Machine and Per-User installation modes of Workspace are also supported in Citrix XenDesktop. 

VMware installation 
This section describes the installation of products that are required for Workspace deployment to VMware. 

Installing Workspace for VMWare Horizon virtual app 
1. Change to installation mode on the Horizon server, using the command line: 

change user /install  

2. In a command-line interpreter, such as Command Prompt, type the following command line24:  

RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-no --logpath=”<folder_path>” --
cachepath=”<folder_path>”  

⚠ For mass deployment, it is recommended that you define a shared configuration file (or files, for failover purposes23).  

3. Once the installation has finished, change back to execute mode, using the following command line: 

change user /execute  

 
 
22  See Cache path definition in Appendix L: Known issues. 
23  For further information about shared configuration files, see step 3 of Setting up Configuration Manager. 
24  The command line is run from the folder where RefinitivWorkspace.exe file is located and contains paths to the log and cache file locations. 
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Configuring virtual applications on Windows Server 

Installation is completed by publishing both Workspace and Refinitiv Workspace - Excel applications in the VMWare Horizon virtual 
app.  

To publish the applications, perform the following steps using the Horizon Console: 

1. In Horizon Console, select Inventory > Applications 

2. In the Application Pools panel, select Add > Add Manually 

3. For Workspace, in the Add Application Pool panel, shown 
opposite, complete the form using the following details:  

 

4. Click Submit 

The application appears in the Application Pools panel 

5. Select Add > Add Manually 

6. For Refinitiv Workspace - Excel, complete the form using the 
following details: 

 

 
 
25  The Display Name value is a free text field. However, the structure of the ID, Path, and Start Folder entries are a requirement.   

In this field… Type or select this … 

ID RefinitivWorkspace 

Display Name Refinitiv Workspace 25 

Path <install_path>Refinitiv\Refinitiv 
Workspace\RefinitivWorkspace.exe 

Start Folder <install_path>\Refinitiv\Refinitiv 
Workspace\ 

Entitle Users after 
Adding Pool 

Select this checkbox 

Multi-Session Mode Select Disabled 

In this field… Type or select this… 

ID RefinitivWorkspaceExcel 

Display Name Refinitiv Workspace - Excel 25 

Path <install_path>\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe 

Start Folder <install_path>\Refinitiv\Refinitiv Workspace\ 

Parameter --excel 

Entitle Users after Adding Pool Select this checkbox 

Multi-Session Mode Select Disabled 
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7. Click Submit 

The application appears in the Application Pools panel 

8. In the Application Pools panel, click Entitlements 

9. In the Add Entitlements panel, click Add 

The Find User or Group panel, opposite, is displayed 

10. Use the fields in this panel – Domain, Name/User Name, and 
Description – search for existing VMware users and select the 
checkboxes next to their details 

11. Click OK 

Installing Workspace for VMWare 
Horizon virtual desktop 
If you use instant clone desktop pools (golden image), or automated 
full-clone desktop pools, configured to clear changes after the user 
closes a session, you must install Workspace using the no automatic 
update mode. To do so, use the following command line26: 

RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-no --sharedconfig="<file_path>"  

In most cases, the Per-Machine and Per-User installation modes of Workspace are also supported for VMware Horizon virtual 
desktop. 

Running Workspace for Web 
Workspace is also accessible through the Internet or private network.  

Accessing through the Internet 
To access the Workspace sign-in page:  

• Enter the following URL into your browser: 

https:\\workspace.refinitiv.com\web   

Accessing through a private network 
To access the Workspace sign-in page:  

• Enter the following URL into your browser:  

https:\\workspace.extranet.refinitiv.biz\web   

Post installation testing 
Once Workspace has been installed, you can test the data retrieval functions using the testing tool provided in Refinitiv Workspace 
- Excel.  

Downloading the tool 
To download the testing tool, do the following: 

1. Run Refinitiv Workspace - Excel 

2. Under the Workspace menu:  

a) Sign in, if necessary 

 
 
26  Although not shown in this example, as for the virtual app, the command line should include the log and cache paths, which must point to the 

same location from where RefinitivWorkspace.exe is run. 

https://docs.vmware.com/en/VMware-Horizon/2203/virtual-desktops/GUID-3F7F5228-26B0-47ED-B381-01B2E2C4A4B1.html
https://docs.vmware.com/en/VMware-Horizon/2203/virtual-desktops/GUID-FB9EEA35-065A-4C4E-906E-E1B9440A5AE7.html
https://docs.vmware.com/en/VMware-Horizon/2203/virtual-desktops/GUID-FB9EEA35-065A-4C4E-906E-E1B9440A5AE7.html
https://workspace.refinitiv.com/web
https://workspace.extranet.refinitiv.biz/web


 LSEG Workspace – Desktop Installation and Configuration Guide 

Installing Workspace 13 

b) Click Templates  

c) In Search for templates…, type test and press 

Enter 

d) In the first search result panel, Refinitiv Workspace 
– Microsoft Excel Functions Test, click the 
Download button  

 

 

 

Once downloaded, the tool template opens automatically:  

Running the tool 
After checking the Prerequisites, listed in the Instructions section, do the following: 

1. Click the Results worksheet tab 

2. Click the START THE TEST button 

The tests usually take less than a minute to run and, should an error occur, you are presented with diagnostic data under the 
relevant tab. 
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Uninstalling Workspace 
You can uninstall Workspace, by: 

• Using the installer user interface, or 

• Using a command 

Using the installer user interface 
You can uninstall Workspace using the standard add and remove functions in 
Windows and macOS 27. For example:  

1. In Windows, under Settings > Apps & features, select Refinitiv Workspace 
and click Uninstall 

2. In the confirmation prompt, click Uninstall again to open the installer UI, 
opposite  

3. Click Uninstall 

4. Once the uninstallation is complete, click Exit 

Using a command 
You can uninstall Workspace using the following command line: 

RefinitivWorkspace.exe --uninstall  

⚠ When the --machine-autoupdate-peruser installation method is used, running the uninstallation command removes the 

Workspace instance in the profile under which it is run. So, for instance, if the master image is removed, all clone images will 
remain installed.   

Log file location 
The uninstallation log file is stored in the %Temp%\Refinitiv Workspace Uninstall Logs\ folder. 

 
 
27  The app removal function in macOS deletes the application folder without displaying the Workspace-specific UI. 
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Configuring Workspace 
You can configure Workspace using the Configuration 
Manager, which is accessed by running the Workspace 
executable with the --config-manager parameter in a 

Command Prompt window or by selecting the Help > 
Configuration Manager option in Workspace.  

See also: 

• Configuration Manager parameters 

• Customer managed over Internet 

In this section 
• Configuration Manager command lines 

• Setting up Configuration Manager 

• Converting and modifying an Eikon configuration file 

• Creating a new configuration file manually 

• Configuring Single Sign On (SSO) for Workspace for 
Web 

Configuration Manager command lines 
The command line you use depends on the installation type: 

• For User installations, use the command:  

"<InstallDir>\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe" --config-manager  

• For Machine installations, use the command: 

"<InstallDir>\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe" --config-manager --machine  

Setting up Configuration Manager 
In the Configuration Manager, choose your settings for the following panels: 

1. In the Network panel, set the connection type in your environment to either Internet (the default value) or private network. 

2. In the Client SSO panel, if you have SAML 2.0 set up, enter the URL in the Client Single Sign On (SSO) field.  

3. In the Shared Configuration panel, select whether you are using a shared configuration, which overrides other settings.  

⚠ Defining a shared configuration file (or files, for failover purposes) is optional but strongly recommended for mass 
configuration, as it allows you to define configuration parameters for all users from a single location. 

Workspace uses different settings.json files 28 based on the type of installation: 

• For User installations, the file stores user-specific settings that are controlled by the user and can be found in the following 
location: 

%AppData%\Refinitiv\Refinitiv Workspace\Config\user-settings.json  

• For Machine or Hot-Desking installations, the file stores machine-specific settings that are controlled by elevated 
computer administrator rights and can be found in the following location: 

%ProgramData%\Refinitiv\Refinitiv Workspace\Config\machine-settings.json 

 
 
28  A shared <override_settings>.json configuration file takes priority over local user-settings.json or machine-settings.json 

configuration files. When using the –-sharedconfig parameter, Workspace reads the configuration from the specified location every time it is 
launched. 
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You can specify one or, for failover purposes, more configuration files that can be used across multiple desktops by putting 
these files on a shared drive or Web server (formerly Configuration Proxy concept).  

To do this:  

a) Click Export and navigate to the configuration file, <override_settings>.json, from the Configuration Manager. 

b) Place this file on a shared drive or a Web server. 

c) Enter the URL or UNC path of the file into the installation command line or add this path into the Configuration Manager 
directly. For example: 

\\myserver\config\refinitiv\override-settings.json 

4. In the Streaming panel, shown opposite, you can choose 
streaming sources and whether to activate streaming 
conflation.  

 If you select the From a local LSEG Real-Time 
Advanced Distribution Server (ADS) radio button, the 
settings summarised in steps 5-7 become available. 

The Streaming Conflation rate29 is used for desktop 
performance management by reducing CPU usage in 
downloading streaming data. In effect, it reduces data 
refresh rate from the default (300ms) to every 1.5, 3, or 6 
seconds.  

Also, in the Streaming panel, choose your Streaming 
Data Retrieval source. Data can be streamed from either a Delivery Platform (formerly RDP) or by defining one or more local 
LSEG Real-Time Advanced Distribution Servers30 (formerly ADS).  

Additional customer-managed sites use this connectivity 
to create a connection to the local LSEG Real-Time 
Advanced Distribution Server.  

5. In the Streaming > Servers panel, shown opposite, enter 
the LSEG Real-Time Advanced Distribution Server IP 
address or Hostname, together with the Port31. You can 
also configure the WebSocket32 protocol to enable 
encrypted or unencrypted connections to the Workspace 
platform for streaming services.  

Click + to add additional servers to which connections 
are made simultaneously. These are used if you have 
data feeds from different servers.  

For fallback configuration, you need to add server entries 
in the same tab (Primary, Additional 1, and so on) as the 
server to be supported.  

For further information on WebSocket and Refinitiv Wire 
Format (RWF), refer to the Streaming protocols section. 

6. In the Streaming > Feeds panel, shown opposite, 
configure feeds provided by your local LSEG Real-Time 
Advanced Distribution Server. In Workspace, key letters33 
can be used as single-character shortcuts to identify 
different real-time feeds. Aliases, which perform a similar 
function for Office add-ins, can be up to 32 characters.  

 
 
29  Currently, this capability is for Workspace desktop only and will not affect the conflation settings of the Workspace add-in running under 

Microsoft Office.  

 On Workspace desktop, the highest generally supported conflation rate is 300ms. However, certain exceptions, such as news and chart apps, 
can run at higher update rates. 

30  For further information about configuring Real-Time data, refer to Appendix G: Configuring Real-Time Data products. 
31  Only one server or DNS can be entered for each line. 
32  The WebSocket(ws) protocol provides full-duplex communication channels over a single TCP connection.  For further information, see RFC 

6455: The WebSocket Protocol (rfc-editor.org). 
33  For key letters and aliases, Workspace supports only a subset of ASCII printable characters. That is, the values a-to-z, A-to-Z, and 0-to-9. 

file://///myserver/config/refinitiv/override-settings.json
https://www.rfc-editor.org/rfc/rfc6455.html
https://www.rfc-editor.org/rfc/rfc6455.html
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 While you can assign any of the supported letters or digits to your feeds, the Q key letter must be used to identify a feed that 
provides trade-safe Elektron Real-Time data.  

7. In the Streaming > DACS panel, enter the LSEG Real-
Time Data Access Control System34 username and 
position.  

 

 

 

 

 

 

8. In the Printer panel, opposite, select the default printer or 
output mechanism that is to be used to print trading 
tickets silently. That is, without the need to select the 
printer each time.  

 

 

 

 

 

 

 

 

9. In the Other panel, you can choose whether Workspace 
is to run at above normal priority35 by selecting the Run 
At the highest Available Process Priority Level 
checkbox36.  

You can also select whether links from LSEG apps open 
in Workspace or Eikon37.  

Finally, the Select trading keypad mode applies your 
chosen keypad lighting scheme to the LSEG FX trading 
keypad. 

 

 

 

 

 

 

 

 
 
34  For further information about configuring Real-Time data, refer to Appendix F: Configuring Real-Time Data products. 
35  Currently, this capability is for Workspace running on Windows only and will not affect the process priority of Workspace on macOS or the add-

in running under Microsoft Office. 
36  This can also be achieved by using the command line parameter --run-above-normal-priority. For more information, see Workspace 

executable statements. 
37  You are unable to switch between Eikon 4.0 and Workspace where there was a Citrix installation of Workspace. In Citrix we do not support 

multiple applications to be installed concurrently (Jira ref: EFO-9593). 

https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/W%20O%20R%20K%20S%20P%20A%20C%20E/E%20L%20E%20C%20T%20R%20O%20N/Workspace%20IT%20Managed%20Installation%20Guide/lseg-workspace-1.24-it-managed-installation-guide%20-%20124.09%20d02.docx#_Appendix_E:_Refinitiv
https://jira.refinitiv.com/browse/EFO-9593
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10. In the Logs panel, opposite, you can modify the default 
path for log files, changing from the folder path chosen 
during installation.  

You can also: 

• Choose the depth of logging required.  

• Activate the web logger to troubleshoot networking 
issues. 
 

 

 

 

 

 

11. In the Cache panel, opposite, you can define a new 
folder location for cache files, changing from the folder 
path chosen during installation.  

You can also choose to clear all cache folders or only 
those folders of Electron or your Workspace apps. 
 
 

 

 

 

 

 
 

12. Finally, in the Tools panel, use the Eikon 4 configuration 
converter tool to convert an existing Eikon configuration 
file to Workspace-compatible .json format. 

For further information, see the section below. 

 

 

Converting and modifying an Eikon configuration file 
For test purposes, in the Tools panel of the Configuration Manager, you can use the Eikon 4 configuration converter to convert 
an existing OverrideConfiguration.xml file to .json format. 

To convert and modify an existing file: 

1. Click the Eikon 4 Configuration Converter button. 

2. Select your saved .xml file. For example:  

\\myserver\config\refinitiv\OverrideConfiguration.xml 

3. Click Open.  

The file is converted, and the converted configuration file is then displayed. 

4. Click OK.  

5. [Optional] Change your Network and SSO configuration.  

6. Check that the Streaming settings are correct and make any necessary changes. 

7. Click Export to create a new file with a .json extension. 

⚠ The converted .json file still contains legacy configuration settings from Eikon, which could potentially raise issues. 
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Creating a new configuration file manually 
To create a clean Workspace configuration file: 

1. Delete your currently loaded configuration file. 

2. Copy specific parameters from the Eikon Configuration Manager to the Workspace Configuration Manager.  

Parameters in the Eikon Configuration Manager largely share the same names as their counterparts in Workspace. However, the 
following table lists the exceptions (parameter and location): 

 In Eikon… In Workspace… 

Parameter  Distributors Hostname or IP 

Location Configuration: Customer Managed (Local Configuration 
Files) > Real-Time tab > ADS Connection – RSSL protocol 

Streaming > Servers 

Parameter  User Name Username 

Location Configuration: Customer Managed (Local Configuration 
Files) > Permissions tab > DACS Identification 

Streaming > DACS 

 

For more complex environments and further support, contact Workspace technical support, who can assist in converting the 
content of the OverrideConfiguration.xml and RFA.RFA-configuration-files. 

Configuring Single Sign On for Workspace for Web 
Required configuration for when LSEG is the Service Provider (SP): 

• Embed the Workspace Web access URL within the Identity Provider (IDP) initiated login URL. This redirects to Workspace 
after a successful login.  

For example: 

https:\\id-abc.com\abc-sso\eikonweb?RelayState=https:\\workspace.refinitiv.com\web  

The appropriate attribute name must be used, as indicated by the IDP software, for example, RelayState or 

TargetResource. 

 

https://my.refinitiv.com/content/mytr/en/helpandsupport.html
https://id-abc.com/abc-sso/eikonweb?RelayState=https://workspace.refinitiv.com/web
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Appendix A: Folders and files 
This appendix largely focuses on file locations and sizes, and their authentication and verification. 

In this section 
• Packages 

• Executable files 

• Digital signatures 

• Registry files 

• Configuration file settings 

• Shortcuts 

• Default folder and file structures 

• Qualified proxy methods 

• HTTP/1.1+ compliant proxy 

Packages  
The information below can be used by IT when creating an installation package and providing documentation for future updates to 
the application. 

Download locations  
You can download the latest version of the installation file, RefinitivWorkspace-installer_x.xx.xx.exe, from the locations 

listed in the table below.  

Location Link 

Internet https://www.lseg.com/en/data-analytics/products/workspace/download-workspace    

Private network https://workspace.extranet.refinitiv.biz/Apps/ProductDownloadPage/ 

 

Installer file sizes 
The installer executable size is operating system dependent: 

Operating System Size (Megabits) 

Microsoft Windows ~100 

Apple macOS ~200 

 

Executable files 
The core installation of Workspace has the following executables:  

Process Name Service 

RefinitivWorkspace.exe LSEG Workspace (the main Workspace process) 

Refinitiv-host.exe Session Sharing Chrome Extension 

https://www.lseg.com/en/data-analytics/products/workspace/download-workspace
https://workspace.extranet.refinitiv.biz/Apps/ProductDownloadPage/
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Process Name Service 

RWupdaterService.exe Software update installation service38 

Refinitiv.Workspace.BatchService.UserInteraction.exe (Optional) Batch print service 39 

Setup.exe Called by the main processes to perform various sub-
processes 

 

Workspace uses .zip for updates. This may change in future releases, when smaller (delta) installation packages are introduced. 

Digital signatures 
The executable (.exe) and dynamic link library (.dll) files are digitally signed. 

From Workspace version 1.24, these files will be signed using new digital certificates. This code signing certificate retains the same 
Issuer value but has different Subject and Thumbprint values. The new certificates do not impact builds of Workspace released 
prior to version 1.24.  

For further information, refer to PCN208112 - LSEG Workspace 1.24 - New digital certificate. 

Digital certificates  
LSEG uses the following digital certificates for verification purposes. 

Workspace 1.24 or higher 

LSEG signature  

Publisher London Stock Exchange Group PLC 

Subject C=GB/S=London, City of/O=London Stock Exchange Group plc/CN=London Stock Exchange Group plc 

Issuer C=GB/O=Sectigo Limited/CN=Sectigo Public Code Signing CA R36 

Thumbprint 5E56E4978E9D9F19C1298C55E1E6373DFAF44A6F 

Expiration Friday, April 24, 2026, 11:59:59 PM 

 

macOS signature  

Publisher REFINITIV US LLC 

Subject C=US/O=REFINITIV US LLC/OU=YHNVBQZ486/CN=Developer ID Application: Refinitiv US LLC 
(YHNVBQZ486)/UID=YHNVBQZ486 

Issuer C=US/O=Apple Inc./OU= Apple Certification Authority/CN=Developer ID Certification Authority 

Thumbprint 148A8BC109B61AB34D6688249545B40983E3DD44 

Expiration Friday, September 8, 2028, 03:17:30 GMT 

 

 
 
38  The update installation Windows service is used to manage machine mode updates. 
39  The Batch Print service is an optional download, used to print or save documents from the search results grid.  

The service can be downloaded using the following URL: 
https:\\cdn.refinitiv.com\public\packages\batchsaveinstall\RefinitivWorkspaceBatchService.msi  

https://my.refinitiv.com/content/mytr/en/product-notifications/details.html?id=PCN208112
https://cdn.refinitiv.com/public/packages/batchsaveinstall/RefinitivWorkspaceBatchService.msi
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Workspace 1.23 or earlier 

All Desktop and native apps files stamped with the previous or expired certificates are not affected by this change and will remain 
validly signed without any time limit. 

Refinitv signature40 Build date 

 Before 06 March 2022 06 March 2022 - Expiration 

Publisher REFINITIV US LLC REFINITIV US LLC 

Subject C=US/PostalCode=10036/S=New York/L=New 
York/STREET=3 Times Square/O=REFINITIV US 
LLC/CN=REFINITIV US LLC 

C=US/S=New York/O=REFINITIV US 
LLC/CN=REFINITIV US LLC 

Issuer C=GB/S=Greater Manchester/L=Salford/O=Sectigo 
Limited/CN=Sectigo RSA Code Signing CA 

C=GB/O=Sectigo Limited/CN=Sectigo Public Code 
Signing CA R36 

Thumbprint 9b0690d65bdd567afb4ccfd5e3e704abe88a8ffd faeb75e9e11605257a0c9b32c8c1f4aa61245276 

Expiration 05 March 2022, 23:59:59 24 November 2023, 23:59:59 

 

Microsoft signature  

Publisher Microsoft Corporation 

Subject C=US/S=Washington/L=Redmond/O=Microsoft Corporation/CN=Microsoft Corporation 

Issuer C=US/S=Washington/L=Redmond/O=Microsoft Corporation/CN=Microsoft Code Signing PCA 2010 

 

macOS signature  

Publisher REFINITIV US LLC 

Subject C=US/O=REFINITIV US LLC/OU=YHNVBQZ486/CN=Developer ID Application: Refinitiv US LLC 
(YHNVBQZ486)/UID=YHNVBQZ486 

Issuer C=US/O=Apple Inc./OU= Apple Certification Authority/CN=Developer ID Certification Authority 

Thumbprint B69FD35BFD9D7FFE877DCF570A4EFC7D4E8ADCFA 

Expiration Wednesday, October 16, 2024, 14:47:34 GMT 

 

Registry files 
Installation mode Description Registry key User 

User  The registry is deployed only once, at 
installation time 

HKCU41 Current user 

Machine with an auto-
update per user  

The registry is deployed multiple times, as it 
depends on Active Setup 

HKCU, HKLM Every user (Separate user 
profile) 

Machine with auto-update  
service or no auto-updates 

The registry is deployed only once, at 
installation time. 

HKLM42 Every user 

 

 
 
40  For further information, refer to PCN 13469. 
41  HKEY_CURRENT_USER 
42  HKEY_LOCAL_MACHINE 

https://my.refinitiv.com/content/mytr/en/pcnpage/13469.html
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Configuration file settings  
The following settings are customizable in your .json configuration file. 

Setting Customization 

EIKON.STREAMING.API.LOCAL.ALLOWHOSTEDFALLBACK Defining this setting as false, indicates that you do not want 

Workspace to fall back to the Common Platform hosted streaming 
servers. In this case, if the connection to all configured local server 
URLs fails, Workspace is unable to retrieve streaming data.  

By default, Workspace systematically attempts to connect to the 
Common Platform hosted streaming servers, if no local connection 
can be made. 

EIKON.STREAMING.API.LOCAL.DACS.APPLICATIONID This setting allows you to customize the DACS application ID, for 
Workspace it is 56 by default.  

CLIENTSSO_URL.ENABLED 
CLIENTSSO_URL 

Support Client SSO service to allow the user to use company 
credentials to login. 

Shortcuts 
There are two shortcuts created under the Refinitiv folder, found under the Windows Start menu: 

• Refinitiv Workspace 

• Refinitiv Workspace - Excel 

Default folder and file structures 
The following table contains the default folder structures for User and Machine installations, and includes the location under which 
the structures are created: 

Service Location Structure 

User installation  

n/a %LocalAppData% Refinitiv for Office 
└── 1.20.68 
   └── config 
       └── addin.config.json 
   └── Office_x64 
       └── refinitiv-shim.dll 
   └── Office_x86 
       └── refinitiv-shim.dll 
Refinitiv Workspace 
└── com.refinitiv.workspace.sessionsharing.json 
└── install-settings.json 
└── installInfo.json 
└── Refinitiv-host.exe 
└── RefinitivWorkspace.exe 
└── locales 
└── resources 
└── swiftshader 
Refinitiv Workspace Install Logs 
Refinitiv Workspace Logs 
Refinitiv Workspace.versions 
└── 1.21.344 
Refinitiv Workspace.ToInstall 
└── RFVWWindows_Core_1_21_276.zip 
└── Extract 
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Service Location Structure 

 %AppData% Refinitiv Workspace 
└── Local State 
└── Cache 

Machine Installation  

With auto-
update 
service 

%ProgramFiles% Refinitiv for Office 
└── 1.20.68 
    └── config 
        └── addin.config.json 
    └── Office_x64 
        └── refinitiv-shim.dll 
    └── Office_x86 
        └── refinitiv-shim.dll 
Refinitiv Workspace 
└── install-settings.json 
└── RefinitivWorkspace.exe 
└── 1.21.344 
    └── com.refinitiv.workspace.sessionsharing.json 
    └── installInfo.json 
    └── Refinitiv-host.exe 
    └── RefinitivWorkspace.exe 
    └── RWupdaterService.exe 
    └── locales 
    └── resources 
    └── swiftshader 

 %ProgramData% Refinitiv Workspace 
└── pmInstallInfo.json 
└── userInfo.json 
Refinitiv Workspace Install Logs 
Refinitiv Workspace.versions 
└── 1.21.344 
Refinitiv Workspace.ToInstall 
└── RFVWWindows_Core_1_21_276.zip 
└── Extract 

 %LocalAppData% Refinitiv Workspace Logs 

 %AppData% Refinitiv Workspace 
└── Local State 
└── Cache 

With  
auto-update 
per user 

%ProgramFiles%\Refinitiv Refinitiv for Office 
└── 1.20.68 
    └── config 
        └── addin.config.json 
    └── Office_x64 
        └── refinitiv-shim.dll 
    └── Office_x86 
        └── refinitiv-shim.dll 
Refinitiv Workspace 
└── com.refinitiv.workspace.sessionsharing.json 
└── install-settings.json 
└── installInfo.json 
└── Refinitiv-host.exe 
└── RefinitivWorkspace.exe 
└── locales 
└── resources 
└── swiftshader 
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Service Location Structure 

 %ProgramData%\Refinitiv Refinitiv Workspace 
└── pmInstallInfo.json 
└── userInfo.json 
Refinitiv Workspace Install Logs 
Refinitiv Workspace.versions 
└── 1.21.344 

 %LocalAppData%\Refinitiv Refinitiv for Office 
└── 1.20.68 
    └── config 
        └── addin.config.json 
    └── Office_x64 
        └── refinitiv-shim.dll 
    └── Office_x86 
        └── refinitiv-shim.dll 
Refinitiv Workspace 
└── com.refinitiv.workspace.sessionsharing.json 
└── install-settings.json 
└── installInfo.json 
└── Refinitiv-host.exe 
└── RefinitivWorkspace.exe 
└── locales 
└── resources 
    └── app.asar 
    └── deployment.asar 
    └── package.zip 
    └── REFINITIVEXCEL.ico 
    └── REFINITIVMESSENGER.ico 
    └── REFINITIVWORKSPACE.ico 
    └── versionInfo.json 
    └── app.asar.unpacked 
└── swiftshader 
Refinitiv Workspace Logs 
Refinitiv Workspace.ToInstall 
└── RFVWWindows_Core_1_21_276.zip 
└── Extract 

 %AppData%\Refinitiv Refinitiv Workspace 
└── Local State 
└── Cache 

 %Temp% Refinitiv Workspace Uninstall Logs 

Without 
auto-update 
service 

%ProgramFiles%\Refinitiv Refinitiv for Office 
└── 1.20.68 
    └── config 
        └── addin.config.json 
    └── Office_x64 
        └── refinitiv-shim.dll 
    └── Office_x86 
        └── refinitiv-shim.dll 
Refinitiv Workspace 
└── com.refinitiv.workspace.sessionsharing.json 
└── install-settings.json 
└── installInfo.json 
└── Refinitiv-host.exe 
└── RefinitivWorkspace.exe 
└── locales 
└── resources 
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Service Location Structure 

└── swiftshader 

 %ProgramData%\Refinitiv Refinitiv Workspace 
└── pmInstallInfo.json 
└── userInfo.json 
Refinitiv Workspace Install Logs 
Refinitiv Workspace.versions 
└── 1.21.344 

 %LocalAppData%\Refinitiv Refinitiv Workspace Logs 

 %AppData%\Refinitiv Refinitiv Workspace 
└── Local State 
└── Cache 

 %temp% Refinitiv Workspace Uninstall Logs 

 

Qualified proxy methods 
Workspace is qualified with the following authenticated proxy methods: 

Proxy Authentication Method 

Squid 2.7 • No authentication 

• Basic 

• Digest 

• NTLM 

• Kerberos 

Squid 3.5.28 • Basic 

• Digest 

 

HTTP/1.1+ compliant proxy  
As a minimum, Workspace requires HTTP/1.1. Workspace can attempt to use HTTP/2 but falls back to HTTP 1.1 if it is not viable.  

As such, to have the best connection between the Workspace key station and the LSEG Platform on the head end, it is vital that 
you use an HTTP/1.1+ Compliant Proxy.  

⚠ The Streaming Service requires an HTTP keep alive or persistent connection, which is supported in the HTTP/1.1 
specification. 
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Appendix B: Software information and 
support 
In this appendix, links to additional and related information are provided, including relevant documentation locations and an 
overview of the information contained in the About LSEG Workspace dialog, for example. 

In this section 
• Documentation locations 

• Export control classification 

• Hosted connection item limits 

• About LSEG Workspace dialog 

• Data dictionary support 

• Local mode support 

Documentation locations 
Workspace technical content can generally be found in two locations: 

• The documentation section of the LSEG Workspace page. These documents are searchable using all popular search engines 
(such as Google or Bing). 

• Under the Workspace section of MyAccount (formerly MyRefinitiv), the authenticated website. 

Where documents are to be found in other locations, these are provided in the table below: 

Documentation Location(s) 

Workspace Administration Panel Configuration A description of the functions (layouts, version control, and so on) of the 
Workspace Administration Panel can be found in the Configuration Guide. 

Workspace Administration Tools Configuration A description of the functions (group, configuration management, and so on) 
handled by the Client Administration Tools app can be found in 
Administration Tools Guide. 

Workspace System Requirements The system requirements documentation can be found in the System 
Requirements document.  

LSEG Real-Time Data Access Control System 
(formerly DACS)43 

The DACS permission synchronization requirements can be found in the 
DACS Permission Synchronization Configuration Guide, under the DACS 
section of MyAccount. 

LSEG Real-Time Advanced Distribution Server44 
(formerly ADS)   

An overview of the ADS WebSocket connection configuration can be found 
in the ADS Software Installation Manual, under the Advanced Distribution 
Server (ADS) section of MyAccount.  

LSEG Real-Time Advanced Distribution Hub 
(formerly ADH) 

Content covering the installation and configuration of the LSEG Real-Time 
Advanced Distribution Hub can be found in the Advanced Distribution Hub 
section of MyAccount. 

Financial Community Network (FCN) and Delivery 
Direct 

For further information about FCN and Delivery Direct, see the Private 
Network Overview section of MyAccount. 

 
 
43  DACS Permission Synchronization for Workspace is recommended – rather than the DPRM service - to prevent misconfiguration or permission 

issues between the Delivery Platform (formerly RDP) and local LSEG Real-Time Distribution System. 

 While we recommend DACS, for information regarding the configuration of the DPRM service, refer to Appendix E: Settings. 
44  For further information about configuring Real-Time data, refer to Appendix G: Configuring Real-Time Data products. 

https://www.lseg.com/en/data-analytics/products/workspace#documentation
https://my.refinitiv.com/content/mytr/en/product/refinitiv-workspace.html
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/administration-panel-configuration-guide.pdf
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/administration-tools-configuration-guide.pdf
https://www.refinitiv.com/content/dam/marketing/en_us/documents/support/workspace/system-requirements.pdf
https://www.refinitiv.com/content/dam/marketing/en_us/documents/support/workspace/system-requirements.pdf
https://my.refinitiv.com/content/dam/myrefinitiv/products/607/en/Technical/634430.pdf
https://my.refinitiv.com/content/mytr/en/product/data-access-control-system-(dacs).html
https://my.refinitiv.com/content/mytr/en/product/data-access-control-system-(dacs).html
https://my.refinitiv.com/content/mytr/en/product/real-time-advanced-distribution-server.html
https://my.refinitiv.com/content/mytr/en/product/real-time-advanced-distribution-server.html
https://my.refinitiv.com/content/mytr/en/product/real-time-advanced-distribution-hub.html
https://my.refinitiv.com/content/mytr/en/product/real-time-advanced-distribution-hub.html
https://my.refinitiv.com/content/mytr/en/policies/private-network-overview.html
https://my.refinitiv.com/content/mytr/en/policies/private-network-overview.html
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Documentation Location(s) 

Chrome Extension For further information about the Google Chrome extension, see the 
Chrome Extension Installation Guide. 

Release Notes A summary of the features in the latest release of Workspace can be found 
in the Release Notes document. 

Service Description The Workspace Service Description document can be found in the Service 
Description document. 

Workspace Vendor Subservice Definitions A list of the Products, Exchanges, and Specialist Data definitions can be 
found in the Vendor subservice definitions document. These are managed 
using the LSEG Real-Time Data Access Control System (DACS). 

Technical Roadmap A tabular summary of known significant changes to upcoming releases of 
Workspace can be found in the Technical roadmap document. 

 

Export control classification 
The following table contains export control classification details for Workspace: 

Program Name Refinitiv Workspace 

ICOS Reference 6420 

Program Version 1.x 

Sub-Products 6413 for Windows & 6414 for macOS 

 

ECCN (United States) EAR99 

ECCN (European Union) None 

Refinitiv Export Code NL 

Export Note This export code means ‘Not Licensable’ and is applied to items that can be exported ‘no 
license required’, under both EU and US regulations. Exports of NL items can be made to 
all countries except embargoed countries (Iran, Syria, North Korea, Cuba, or Crimea). 

US Commerce, BIS CCATS number self-classified 

 

Hosted connection item limits 
For the deployed desktop hosted connection, the Item limit is 2500. This can be extended to 5000, with a fee-liable Product Line 
Item (PLI) add-on. 

 For Workspace for Web, the item limit is 1000 and cannot be extended for performance reasons. 

Once the limit is reached, a message is displayed in the About LSEG Workspace > Streaming panel. 

About LSEG Workspace dialog 
The About LSEG Workspace dialog box provides information about the viewed Workspace installation and environment.  

To open the About LSEG Workspace dialog, In Workspace:  

• Click Help > About Refinitiv Workspace 

https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/chrome-extension-installation-guide.pdf
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/release-notes.pdf
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/service-description.pdf
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/service-description.pdf
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/vendor-subservice-definitions.pdf
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/workspace-and-eikon-technical-roadmap.pdf
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The dialog box divides information over five panels:  

• System status contains Workspace 
version and variant information, 
together with service connection 
details and an overview of the 
computer on which this iteration of 
Workspace is running.  

• Streaming contains information about 
real-time data sources, including the 
primary feed used, RICs used45 
(subscriptions), and any other feeds 
provided through a local LSEG Real-
Time Distribution System. 

• User details contains information 
about the currently logged in user, 
including their email address, their 
user unique identifier (UUID), job role, 
and location information. 

• Along with the proxy URL and version, 
the Data API proxy panel also 
contains information about the status 
of the proxy, indicating whether it is 
available for external connections. 

• Component versions contains 
version information about services and apps that have been made available to the user. 

Data Dictionary support 
Access to a Data Dictionary is dependent on your connection support. For:  

• Hosted streaming connections, the data dictionary is provided and managed by LSEG. 

• Local Real-Time Distribution System46 connections, Workspace downloads the data dictionary from the primary Real-Time 
Advanced Distribution Server. 

Local Mode support 
The Local Mode feature, as found in Eikon, is not supported. 

 

 

 
 
45  See the Hosted connection item limits section. 
46  For further information about configuring Real-Time data, refer to Appendix F: Configuring Real-Time Data products. 

https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/W%20O%20R%20K%20S%20P%20A%20C%20E/E%20L%20E%20C%20T%20R%20O%20N/Workspace%20IT%20Managed%20Installation%20Guide/lseg-workspace-1.24-it-managed-installation-guide%20-%20124.09%20d02.docx#_Appendix_E:_Refinitiv
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Appendix C: Command line statements  
In this appendix, the command line statements that can be used to install, uninstall and configure LSEG Workspace, in different 
scenarios, are provided. 

In this section 
• Installation statements 

• Uninstallation statements 

• Configuration Manager parameters 

• Workspace executable statements 

Installation statements 
The table below list command line statements that can be used to install Workspace: 

Installation mode Command 

Base commands  

User 47 RefinitivWorkspace-installer_x.xx.xx.exe --user  

Machine  RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-peruser 

Machine without Auto-Update RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-no 

Machine with Update Service RefinitivWorkspace-installer_x.xx.xx.exe –-machine-autoupdate-service 

SSO  RefinitivWorkspace-installer_x.xx.xx.exe --client-sso=<client SSO URL> 

Installation help page RefinitivWorkspace-installer_x.xx.xx.exe --help 

Run Messenger only RefinitivWorkspace-installer_x.xx.xx.exe --messengeronly 

Shared configuration 48 49  

Additional parameter --sharedconfig="<file path>" 

Failover --sharedconfig="<file path-1>";"<file path-2>";"<file path-3>" 

 

Related information can be found in the Performing an installation using your Single Sign On URL section. 

Uninstallation statement 
The following command line statement can be used to uninstall Workspace: 

RefinitivWorkspace.exe --uninstall 

 
 
47  This is the default method of installing Workspace. As such, the –-user parameter is not a requirement. 
48  For example, RefinitivWorkspace-installer_x.xx.xx.exe --machine-autoupdate-peruser --sharedconfig="<file path>" is 

the command line for a machine installation with a shared configuration. 
49  The content of the file(s), identified by the --sharedconfig parameter, could change from version-to-version. So, refer to the appropriate 

documentation for amendments to this parameter when there is a new release. 
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Configuration Manager parameters 
The table below list command line statements that can be used to configure Workspace: 

Installation mode Command 

User "<InstallDir>\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe" --config-manager  

Machine or Hot-
Desking 

"<InstallDir>\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe" --config-manager 
--machine 

Executable statements 
There are various parameters you can add to the Workspace installer and desktop executable, which are covered in the following 
two sections. 

Desktop executable parameters 
The following command line structures are used for the desktop executable50, where all parameters are optional: 

• Windows: RefinitivWorkspace.exe <parameter 1> <parameter n> 

• macOS: open /Applications/"Refinitiv Workspace.app" --args <parameter 1> <parameter n> 

The optional parameters that can be used in conjunction with these commands are described below: 

Parameter Purpose 

--clearCache  
--clearElectronCache  

Clear the Electron cache of Workspace (<install 
path>\Refinitiv\Refinitiv Workspace\Cache\Electron) 

--clearLogs Clear the application logs folder of Workspace 

--clearRememberMe   Delete the automatic login cookie 

--client-sso=<url> Set the URL for your SSO 

--config-manager Open the Workspace Configuration Manager (see the Configuring 
Workspace section) 

--connection=internet Force the use of Internet connection 

--disable-active-setup Active Setup51 is disabled.  

This parameter is supported in machine-autoupdate-no mode only, as 

Active Setup is required when the auto-update service52 is used.  

--dumpApps Dump available Apps of Workspace into the logs folder 

--dumpConfig53 Dump the configuration of Workspace into the logs folder 

--excel    Start Excel with the Workspace ribbon add-in 

--help Display available command line options. 

 
 
50  The desktop executable is, by default, found in the %ProgramFiles%\Refinitiv\Refinitiv Workspace\<version>\ folder. 
51  Windows Active Setup is a mechanism for executing commands once per user during login. 
52  If Workspace is in use when it is being updated automatically, the previous <Version> folders under Refinitiv Workspace and Refinitiv for 

Office are preserved. Once all users have logged out of their devices and logged in again, access to the new Workspace version is facilitated 
using Active Setup. 

53  For further information regarding settings that are added to the logs folder, see the Additional dumpConfig statements section. 
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Parameter Purpose 

--language=<xx> Forces the user interface language for Workspace. Where <xx-XX> is: 

• en  English 

• ja  Japanese 

• zh  Traditional Chinese 

• de  German 

--log-level=<level> Set the level of detail for log files, where <level> is: 

• error 
• warning 
• information 
• verbose 
• debug 

--nofile    Start system tray icon only. 

--resetCache Reset the product cache of Workspace to its default state (as after a fresh 
installation) 

--rollback See the Rolling back section, in Appendix M: Known issues. 

--rollforward See the Rolling forward command support section, in Appendix M: Known 
issues. 

--run-above-normal-priority Dependent on user rights, in Windows only, raise the priority of 
Workspace processes. 

--systemtest    Run the embedded System Test54. 

--uninstall Uninstall Workspace. 

--update-office-registry=<value> Used to update the office registry key, where <value> is either HKLM or 

HKCU. 

For additional information, see Excel add-in loading issues. 

--upload-logs Upload log files. 

--version Show the version of Workspace55. 

--versions Display the version of underlying components of Workspace, for example:  
--versions=electron, node (or simply --versions).  

--web-logger For network troubleshooting purposes, this is used in capturing Web calls 
when running Workspace. See the Networking issues section, in 
Appendix L: Troubleshooting. 

Installer parameters 
The following parameters can be found in the help file for Workspace installer, RefinitivWorkspace-installer_x.xx.xx.exe: 

Parameter Purpose 

Installation types  

--machine-autoupdate-no Machine installation, with no automatic updates 

 
 
54  For further information regarding the System Test applications, refer to the Workspace System Test Guide. 
55  On macOS, for this command to work as intended, go to the /Applications/Refinitiv Workspace.app/Contents/MacOS folder and run 

the command, ./RefinitivWorkspace --args --version. 

https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/system-test-guide.pdf
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Parameter Purpose 

--machine-autoupdate-peruser Machine installation, with an automatic update per user 

--machine-autoupdate-service Machine installation, with an automatic update service 

--uninstall Uninstall operation 

--permachine This command has been replaced by the machine parameters and is no 
longer valid. 

--rollback Restore the previous, automatically-installed version. See the Rolling 
back section, in Appendix M: Known issues. 

--update This command has been replaced by the other parameters and is no 
longer valid. 

--updateInstallationConfiguration Repair the Workspace deployment configuration file. 

--user User installation (default) 

--vdi VDI installation mode 

Options  

--adminprivilege No longer valid. 

--cachepath=<Your CachePath> Allows you to customise the cache location, where <Your CachePath> 

is the path to the cache folder. 

--client-sso=<Your ClientSSO URL> Allows the installer to set up SSO, once Workspace installation is 
complete. Where, depending on the installation mode of Workspace, 
SSO settings are stored under user-settings.json or machine-
settings.json. 

--disable-active-setup Active Setup56 is disabled.  

This parameter is supported in machine-autoupdate-no mode only, 

as Active Setup is required when the auto-update service57 is used. It is 
also recommended that it is combined with –-office-registry=HKLM, 

as the Office Registry is not required to synchronise with HKCU. 

See also the Excel add-in loading issues section, found in Appendix M: 
Known issues. 

--disable-pi Disable sending usage tracking information to LSEG. 

--execute=<execute> To identify the process that the update will wait until this process closed 
properly and perform the update. 

--forceInstall58 Bypasses the system pre-requisites check. 

--help Display external help on the new command line 

--installerlogpath=<Your InstallerLogPath> Allows you to customise the Workspace installation log location, where 
<Your InstallerLogPath> is the path to the Refinitiv Workspace 

Install Logs folder. 

 
 
56  Windows Active Setup is a mechanism for executing commands once per user during login. 
57  If Workspace is in use when it is being updated automatically, the previous <Version> folders under Refinitiv Workspace and Refinitiv for 

Office are preserved. Once all users have logged out of their devices and logged in again, access to the new Workspace version is facilitated 
using Active Setup. 

58  Do not use this flag without a clear purpose and understanding of the impacts, as it may result in degraded product experience. 
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Parameter Purpose 

--installpath=<Your InstallPath> Allows you to customise the installation folder location, where <Your 
InstallPath> is the path to the Refinitiv\Refinitiv Workspace folder. 

--lang="<lang>" To specify the installation language. Where <lang> is: 

en English 

ja Japanese 

zh Chinese 

ko Korean 
 

--logpath=<Your LogPath> Allows you to customise the Workspace log location, where <Your 
LogPath> is the path to the Refinitiv Workspace Logs folder. 

--messengeronly Installs Workspace Messenger only. This installation mode will not share 
the login session with Workspace. 

--noshortcut Install the product without shortcuts.  

This mode will be used by the REDI59 installer and Workspace will be 
able to start from REDI only. 

--office-registry=<HKLM|HKCU> Install with office registry HKLM or HKCU.  

This parameter is supported in machine-autoupdate-no mode only. 

--sharedconfig=<Your SharedConfigPath> Allows you to specify a custom path to your shared configuration file. 

--shortcuts=<Your ShortCutPath> Allows you to customise the shortcuts folder location. Where <Your 
ShortCutPath> is the path to the Refinitiv Workspace shortcuts 

directly. 

If this option is defined as NONE, shortcuts are not installed. 

--shortcut-excel=<FALSE / TRUE> This parameter determines whether the Refinitiv Workspace - Excel 
shortcut is added to the Start menu, where: 

FALSE    Shortcut is not added 

TRUE     [Default] Shortcut is added 

--shortcut-workspace=<FALSE / TRUE> This parameter determines whether the Refinitiv Workspace shortcut 
is added to the Start menu, where: 

FALSE    Shortcut is not added 

TRUE     [Default] Shortcut is added  

--silent60 Run the installation in silent mode. 

--startApp Automatically start Workspace, once the installation is complete. 

--remote-debugging-port=<port> Support remote debugging port for automate test. 

 
 
59  For further information about REDI, refer to the LSEG product page. 
60  Silent mode is enabled when installing, updating, or uninstalling Workspace, using the command line. 

https://www.lseg.com/en/data-analytics/products/redi-execution-management
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Appendix D: Automatic update workflow 
The content in this appendix applies to the following installation types: 

• --user  

• --machine-autoupdate-peruser 61  

• --machine-autoupdate-service  

The --machine-autoupdate-no installation mode is not discussed, as automatic update functionality is disabled for that mode. 

Device and installation registration 
1. Login into Workspace 

2. During the first minute after login, RefinitivWorkspace.exe retrieves installationGUID from installinfo.json.  

• If installationGUID is not found in installinfo.json, it is created using guid.json 62 

• If installinfo.json does not exist, it is created automatically 

Depending on the installation method, installinfo.json is in one of the following locations: 

Method Location 

User C:\Users\%Username%\AppData\Roaming\Refinitiv\Refinitiv Workspace\ 

Machine with auto update per user <install path>\Refinitiv\Refinitiv Workspace\ 

Machine with auto update service %programdata%\Refinitiv\Refinitiv Workspace\ 

 

3. RefinitivWorkspace.exe sends a request to Desktop Deployment Portal to do the following: 

a) Check whether the device is registered on Desktop Deployment Portal and, if not, add the new device  

b) Add a login history record 

Checking new version availability 
Randomly, between 5-60 minutes after login, RefinitivWorkspace.exe checks63 for the availability of the new target version for 

the current user.  Version checks are then scheduled daily, at 00:<randomMinutes>. 

1. Checks the new version with Admin Panel64 

2. Checks the new version with Desktop Deployment Portal 

Changing the update time 
To change update time after login, use the command --checkupdateTime=<n>, where: 

• --checkupdateTime=0 – Checks for a new version instantly after login 

• No parameter set – Checks for a new version randomly between 5-60 minutes after login 

 
 
61  For --machine-autoupdate-peruser mode only: To update the master installation automatically (bulk autoupdate), the administrator should 

get the latest version and reinstall Workspace. All users, that have a lower version than the master installation, are updated to the new version 
of master installation automatically, with the active setup, once they log off from Windows, and log in again. 

62  Guid.json is located under C:\Users\%Username%\AppData\Roaming\Refinitiv\Refinitiv Workspace\ 
63  This check can also be triggered by opening the About box. 
64  For further information, see the Administration Panel Configuration Guide. 

https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/administration-panel-configuration-guide.pdf
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Setting up a custom scheduler 
To set up a custom scheduler to check for new versions, use the command:  

--autocheckupdatetime=<a> <b> <c> <d> <e> 

Where: 

<a>  Day of week (0 – 7, where 7 is Sunday). You can also use names, that is, Monday, and so on. 

<b>  Month (1 - 12) 

<c>  Day of month (1 - 31) 

<d>  Hour (0 - 23) 

<e>  Minute (0 - 59) 

 

For example, for an update check to be performed every Sunday, at 5:30 PM, use the command: 

--autocheckupdatetime=7 * * 17 30 

Downloading a version and preparing for upgrade 
If a new version is detected, the following steps are performed: 

1. Workspace receives the target version information (including URL) and automatically downloads the zipped package. 

Calling process  RefinitivWorkspace.exe 

URL   https:\\cdn.refinitiv.net\public\packages\RFVWWindows\RFVWWindows_Core_x_xx_xxx.zip 

 

Installation type Download location 

--user 
--machine-autoupdate-peruser 

%AppData%\Local\Refinitiv\Refinitiv Workspace.ToInstall 

--machine-autoupdate-service 
%programdata%\Refinitiv\Refinitiv Workspace\Refinitiv 
Workspace.ToInstall 

 

2. Workspace extracts the files from the zipped file to a newly created Extract folder  

Calling process  RefinitivWorkspace.exe 

Unzip tool  yauzl node_module (https:\\www.npmjs.com\package\yauzl) 

Extract location <Download location>\Extract 

Checking new package with Desktop Deployment Portal 
3. Checks whether the content in the Extract\checkUpdateInfo.json matches the content received from the Desktop 

Deployment Portal (by checking the file hash code):  

If… Then…  

Yes  Skip downloading the new package and wait for the upgrade initiation 

No Delete the downloaded package and Extract folder 

 

4. Download the new package, with the updated Extract\CheckUpdateInfo.json content (see Downloading a version and 

preparing for upgrade) 

https://cdn.refinitiv.net/public/packages/RFVWWindows/RFVWWindows_Core_x_xx_xxx.zip
https://www.npmjs.com/package/yauzl
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Initiating an update 
The persons required to perform this step depend on the installation type: 

Installation type Performed by 

--user The user of the machine where Workspace was installed 

--machine-autoupdate-peruser Each Workspace user on the machine where the application was installed 

--machine-autoupdate-service Any user of the machine(s) where Workspace was installed 

 

To begin the upgrade: 

1. Select the Help menu 

2. Choose About LSEG Workspace 

3. Click the Upgrade now button 

RefinitivWorkspace.exe runs an Extract\setup.exe command, with arguments based on setupArgs, defined in 

CheckUpdateInfo.json. 

Installation type Example command 

--user 
--machine-autoupdate-peruser 

setup.exe --update --rerun --silent --forceInstall --
calledByCheckupdate --execute=RefinitivWorkspace.exe --appLocation= 
C:\\Users\\%Username%\\AppData\\Local\\Refinitiv\Refinitiv Workspace 

--machine-autoupdate-service setup.exe --update --rerun --silent --forceInstall --
calledByCheckupdate --execute=RefinitivWorkspace.exe -- 
appLocation=C:\\Program Files\\Refinitiv\Refinitiv Workspace\\1.19.447 

 

Upgrade workflow 
The following actions are performed by Extract\Setup.exe: 

1. Waits for several seconds until RefinitivWorkspace.exe is terminated 
65 

2. Performs a backup of installation folders, based on the information in the files section of InstallInfo.json 

a) --machine-autoupdate-service only: Checks whether Workspace is in use by another user:  

If… Then… 

Yes Go to step 2.iii 

No Go to step 2.ii  

 

b) Backs up the Workspace installation folder: 

Installation type Installation folder Backup location 

--user 
--machine-autoupdate-peruser 

Refinitiv Workspace <install_path>\Refinitiv Workspace.Backup 

--machine-autoupdate-service Workspace <Version> 
<install_path>\Refinitiv\Refinitiv 
Workspace\<Version>.Backup 

 

 
 
65  If RefinitivWorkspace.exe has not been terminated, Setup.exe force-kills the process.  

 For --machine-autoupdate-service mode: Only the instigating user is required to terminate their Workspace session.   
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c) --machine-autoupdate-service mode only: Checks whether Microsoft Office is in use by another user on the same 

machine: 

If… Then… 

Yes Go to step 2.v  

No Go to step 2.iv 

 

d) Backs up the Refinitiv for Office installation folder: 

Installation type Installation folder Backup location 

--user 
--machine-autoupdate-peruser 

Refinitiv for Office 
<install_path>\Refinitiv for 
Office.Backup 

--machine-autoupdate-service Office <Version> 
<install_path>\Refinitiv for 
Office\<Version>.Backup 

 

e) --machine-autoupdate-service mode only: Performs a backup of the Update Service installation folder:  

Installation type Installation folder Backup location 

--machine-autoupdate-service 
Update Service 
<Version> 

<install_path>\Refinitiv Workspace 
Update Service\<Version>.Backup 

 

3. Backs up the shortcuts folder, based on the information in the shortcutsFolder section of InstallInfo.json:  

Installation type Backup location 

--user 
--machine-autoupdate-peruser 

%appdata%\Refinitiv\Refinitiv Workspace\Backup\<randomname>-
backupShortcut\ 

--machine-autoupdate-service 
%programdata%\Refinitiv\Refinitiv Workspace\Backup\<randomname>-
backupShortcut\ 

 

4. Creates new folders and installs files: 

Installation type Workspace location Office location Update Service location 

--user 
--machine-autoupdate-
peruser 

<install_path>\Refinitiv 
Workspace 

<install_path>\Refinitiv 
for Office n\a 

--machine-autoupdate-
service 

<install_path>\Refinitiv 
Workspace\<Version> 

<install_path>\Refinitiv 
for Office\<Version> 

<install_path>\Refinitiv 
Workspace Update 
Service\<Version> 

 

5. Installs shortcuts: 

Installation Type File location 

--user %AppData%\Microsoft\Windows\Start Menu\Programs\Refinitiv 

--machine-autoupdate-peruser 
%AppData%\Microsoft\Windows\Start Menu\Programs\Refinitiv  
%ProgramData%\Microsoft\Windows\Start Menu\Programs\Refinitiv  

--machine-autoupdate-service %ProgramData%\Microsoft\Windows\Start Menu\Programs\Refinitiv 

 

6. Installs Add/Remove Programs (ARP) registry entries for Workspace. 
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7. Checks whether Workspace was installed with –messengeronly parameter: 

If…   Then…  

Yes  Go to step 9 

No Go to step 8 

 

8. Installs Office Registry and Office Add-ins 

9. Creates install-settings.json, containing settings for Microsoft Office, and providing the location for Workspace and 

Office add-ins: 

Installation Type File location 

--user 
--machine-autoupdate-peruser 

<install_path>\Refinitiv\Refinitiv Workspace\ 

--machine-autoupdate-service <install_path>\Refinitiv\Refinitiv Workspace\<version> 

 

10. Creates com.refinitiv.workspace.sessionsharing.json, providing Chrome extension settings and the location of the 

Refinitiv-host.exe file: 

Installation Type File location 

--user 
--machine-autoupdate-peruser 

<install_path>\Refinitiv\Refinitiv Workspace\ 

--machine-autoupdate-service <install_path>\Refinitiv\Refinitiv Workspace\<version> 

 

11. Checks whether the installation was completed successfully: 

If…   Then…  

Yes  Removes backup folders 66 

No Removes all newly installed files and restores backup folders. 

Ends the installation with an error message. 

 

12. Creates InstallInfo.json, in a mode-specific location, and writes new installation information, such as installation paths, 

shortcut paths, and so on: 

Installation Type File location 

--user 
--machine-autoupdate-peruser 

<install_path>\Refinitiv\Refinitiv Workspace\ 

--machine-autoupdate-service <install_path>\Refinitiv\Refinitiv Workspace\<version> 

 

13. If the update was triggered by signing out, it relaunches Workspace with --startApp  

 

 

 
 
66  For the machine-autoupdate-service only: If Workspace is in use at the time of update, the previous <Version> folders under Refinitiv 

Workspace and Refinitiv for Office are preserved. Once all users have logged out of their devices and logged in again, access to the 
new Workspace version is facilitated using Active Setup. 
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Appendix E: Settings 
This appendix focuses mainly on communications settings and parameters. 

In this section 
• Ports 

• Communication protocols 

• Server software 

• Services 

• Content filtering domains 

• Trusted root certification 

• Customer managed over Internet 

• User Agent 

• FIPS 

Ports  
Workspace uses the following connections: 

API 67 Connection Port 68 

Desktop Data API http:\\localhost:9000\api\ 9000 

Side by Side API 69 http:\\localhost:9000\sxs\ 9000 

Refinitiv Workspace Bus http:\\localhost:49152\ 49152 

 

Communication protocols 

Protocol Port Number  Workspace Services Required For 

TCP 1024+ → 443 

1024+ ← 443 

LSEG Workspace Platform Administration Services 

View Service 

Search & Navigation Service 

Time Series Service 

Workspace Messenger Service 

Trading Service 

Update Service 

Thomson Reuters Remote Support (TRRS) 

Datastream Service 

Newscasts (internet only) 

FXall 

Flextrade Spark 

Real-Time Data  

 
 
67  You can find further information regarding APIs on the Developer Community website. 
68  9000 and 49152 are internal ports. If the port is already in use, Workspace increments until a free port number is found:  

• for Desktop Data and Side by Side, from 9000, and 
• for Workspace Bus, from 49152 

69  For further information, see Workspace Web Side by Side API on the Developer Community website. 

https://developers.lseg.com/en
https://developers.refinitiv.com/en/api-catalog/eikon/workspace-web-side-by-side-api/documentation
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Protocol Port Number  Workspace Services Required For 

TCP 1024+ → 15000 

1024+ ← 15000 

Real-Time Data LSEG Real-Time Advanced Distribution Server70 (formerly 
ADS) 

TCP\UDP 1024+ → 53 

1024+ ← 53 

DNS Server Domain Name Resolution from Domain Name Server 

 

Server software  
For users with a local Real-Time Distribution System infrastructure, including a Real-Time Data Access Control System server, 
DACS Permission Synchronization for Workspace is recommended – rather than the Deployed Permissions Reconciliation 
Manager (DPRM) service. This is to prevent misconfiguration or permission issues between the Delivery Platform (formerly RDP) 
and your local LSEG Real-Time Distribution System. 

While we recommend DACS, for information regarding the configuration of the DPRM service, refer to the DPRM configuration 
section. 

Creating an internal connection 
To create a connection to the LSEG Real-Time Distribution System, you must download the Data Dictionary from a LSEG Real-
Time Connector (RTC) or LSEG Real-Time Advanced Distribution Server.   

For additional information, see the Data Dictionary support section. 

Services  
This section summarizes services and features related to connectivity and provides links to further information.  

Financial Community Network and Delivery Direct  
To access new AWS service endpoints, customers using a private network must whitelist the following new IP addresses, which 
impact Delivery Direct, Financial Community Network (FCN), and Customer Managed Connectivity (CMC) users: 

• 159.43.192.0/23 (AMERS) 

• 159.43.200.0/23 (EMEA) 

• 159.43.208.0/23 (APAC) 

For further information about Financial Community Network and Delivery Direct, see the Private Network Overview section of 
MyAccount (formerly MyRefinitiv), containing the following documents: 

• Customer Connectivity DNS Migration Guide 

• FCN Customer Connectivity Guide 

Internet 
LSEG will not divulge IP address information under any circumstances. Doing so prevents us from changing IP addresses, as and 
when needed, without a notification period. These IP addresses may not always be under our direct control. 

 
 
70  For further information about configuring Real-Time data, refer to Appendix F: Configuring Real-Time Data products. 

https://my.refinitiv.com/content/mytr/en/policies/private-network-overview.html


 LSEG Workspace – Desktop Installation and Configuration Guide 

Appendix E: Settings 42 

Transport Layer Security protocol 
From 01 June 2023, to continue to use LSEG Real-Time services70, you must ensure 
that use of TLS version 1.2 is enabled for all Workspace users.  

To enable TLS 1.2: 

1. In Windows, open the Start menu 

2. Select Windows System > Control Panel 

3. Choose Network and Internet 

4. In the Network and Internet panel, choose Internet Options 

5. In the Internet Properties dialog, shown opposite, select the Advanced tab 

6. Scroll to the Security section (at the end of the settings list) and select Use TLS 1.2 

For further information, refer to PCN205244-Change in supported TLS protocols for 
Eikon and Workspace. 

Web hosted services  
The following services and features are accessed through the Internet and not reached through a private network: 

MyAccount (myaccount.lseg.com) The authenticated documentation repository. 

Contact Us For raising questions, issues, and other topics. 

Desktop crash dump upload utility Sends data to the LSEG support platform. This is in case a user has a session crash. 
The crash data is sent from the user session to Refinitiv, so we can investigate the 
crash. 

GetSupport or interactive Chat Where feedback / support issues are logged, and you can establish a chat dialogue 
with an agent. 

Messenger Traffic  All traffic will be over internet, by default71. 

Portal SDK starter kit (cdn.refinitiv.com) Software Development Kit (SDK) is a toolkit that you can use to interact with the app 
and our platform. This is hosted on CloudFront. 

Chrome Extension This is accessed from an external web site, either by the user going to the Google 
store, or through enterprise set-up.  

 

Content filtering domains 
You need to whitelist the domains for content that can be accessed through Workspace. 

 Third Party apps in Workspace may require access to specific domains. For information about specific access requirements, it 
is advisable to contact the app developer directly.  

Example domain list 
The following list of domains72 is not exhaustive and is for illustrative purposes only. 

DNS Workspace services 

autex.com 
autexnow.com 

Autex 

 
 
71  This is not the case when private line connectivity is enabled for Messenger. For further information, see Appendix I: Workspace Messenger. 
72  Many of the domains listed in the table below are wildcard values, where a subdomain may prepend and/or append the listed domain. 

https://my.refinitiv.com/content/mytr/en/product-notifications/details.html?id=PCN205244
https://my.refinitiv.com/content/mytr/en/product-notifications/details.html?id=PCN205244
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DNS Workspace services 

authenticator.pingone.com 
idpxnyl3m.pingidentity.com 

Multi-factor Ping Authenticator app 

bit.ly 
reut.rs 
tmsnrt.rs 

Bit.ly Integration Information 

trmcs-documents.s3.amazonaws.com Central Bank Polls 

session.rservices.com Contribution address, News documents 

cnbc.com 
ft.com 
moodys.com 

Miscellaneous external content 

googleapis.com Google 

chrome.google.com Workspace Chrome Extension 

virtualearth.net 
thomsonreuters.wdtinc.com 

Interactive Map 

lipperweb.com Lipper Market Insight 

loanconnector.com Loan Connector 

loanpricing.com Loan Pricing 

depth.finance Market Depth 

cdn.mathjax.org MathJax JavaScript display engine 

storage.tr.191.it 
thomsonone.com 
ws.platts.com 

News Documents 

reuters.com 
breakingviews.com 

News URL link 

pi.refinitiv.com Workspace auto-update workflow73  

refinitiv.com 
refinitiv.net 
refinitiv.biz 
thomsonreuters.com 
thomsonreuters.net 
thomsonreuters.biz 

LSEG 

globalrelay.com Workspace Messenger Compliance 

salesforce.com 
webtrendslive.com 

Refinitiv Migration Tools 

kaltura.com 
reuters.tv 

Newscasts (formerly Reuters Insider) 

 
 
73  Whitelisting of this domain is required by all customers using Workspace through Internet and Private Network connections.  
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DNS Workspace services 

vmnd.tv 

cxvid-livecapture.s3.amazonaws.com Newscasts (formerly Reuters Insider): Recording Video and Images 

thomson.112.2o7.net Newscasts (formerly Reuters Insider): Analytics and user interaction reporting 

gstatic.com 
apis.google.com 
bv-predictions2021.com 
cloudfront.net 
google-analytics.com 
googletagservices.com 
product.datastream.com 
themes.googleusercontent.com 
trust.org 
views.rkd.reured.com 

Reuters Interactive graphics 

bing.com Search engine 

media-server.com Street Event content 

comodo.com TLS/SSL Client Certificate (HTTPS) 

tradeweb.com Tradeweb 

fxall.com Trading Service 

pbs.twimg.com 
twitter.com 

Twitter integration 

wom.finance Wealth Order Management 

awsglobalaccelerator.com  

avatars.stocktwits.com Social Media Monitor 

img.en25.com 
eloqua.com 

LSEG Training 

salesforceliveagent.com Support 

oneaccess.io OneAccess 

dtn.com Weather layers in InteractiveMap app 

 

Advanced Dealing FQDNs 
For Advanced Dealing74 customers, the following Fully Qualified Domain Names may need to be configured: 

• app.rad.refinitiv.com (primary and secondary) 

• app.rad.refinitiv.biz (primary and secondary DDN) 

 
 
74  Port 443 is a requirement. For additional information, see the Communication protocols section. 
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Trusted root certification  
You can download and verify certificates from the appropriate location, defined in the table below: 

Internet https:\\cipher-test.refinitiv.com\  

Private network  https:\\cipher-test.extranet.refinitiv.biz\  

 

Certificate details: 

Workspace version 
 

Issued by CN O C 

1.23 and earlier COMODO COMODO RSA 
Certification Authority 

COMODO RSA 
Certification Authority 

COMODO CA Limited GB 

1.24 and later Sectigo Sectigo Public Code 
Signing CA R36 

Sectigo Public Code 
Signing CA R36 

Sectigo Limited GB 

Customer managed over Internet 
Customer managed over Internet mode is a sub deployment, where Workspace connects the real time data on a user’s own local 
LSEG Real-Time Distribution System (formerly TREP) 
infrastructure, while other content is sourced from the 
Delivery Platform (formerly RDP), through the Internet. 

To configure this:  

1. In Workspace, select Help > Configuration Manager. 

2. In the Network panel, under Connection Type, select 
Internet. 

3. In the Streaming panel, under Streaming Data Retrieval, 
select From a local LSEG Real-Time Advanced 
Distribution Server (ADS)75.  

4. This opens three separate panels – Servers, Feeds, and 
DACS – where you can add your server and feed 
information.  

User Agent 
A User Agent is an application that retrieves and presents 
Web content for users or is implemented using Web technologies.  

Workspace identifies connections to the ADS User Agent. For example, this could contain the following string and version:  

RFV-Workspace\<version> 

Where the <version> is updated to match the Workspace executable version. 

FIPS 
Workspace is not supported in a 140 series Federal Information Processing Standards (FIPS) environment.  

 
 
75  For further information about configuring Real-Time data, refer to Appendix G: Configuring Real-Time Data products. 

https://cipher-test.refinitiv.com/
https://cipher-test.extranet.refinitiv.biz/
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Appendix F: Microsoft Office add-ins 
Further information related to the Workspace add-ins for Microsoft Office can be found in the following documents: 

• Workspace Add-Ins – System Requirements, which contains Microsoft 365/Office version requirements, browser compatibility, 
and tools supported by each add-in. 

• Workspace Add-Ins - Workspace Installation Guide and Workspace Add-Ins – Workspace Lite Installation Guide, which 
contains prerequisites, installation, and deployment instructions for the required add-in. 

• Workspace Add-In – Release Notes, which contains a summary of the new features and fixes introduced under each release. 

Workspace for Excel VSTO add-in 
For the Microsoft Excel Visual Studio Tools for Office (VSTO) add-in, Workspace installs a single DLL file under the Windows 
operating system, refinitiv-shim.dll. This supports the core features of the Refinitiv Workspace - Excel (Workspace ribbon) 

add-in. 

MS Office File location 

32-bit <Install_path>\Refinitiv\Refinitiv for Office\x.x.x\Office_x86 

64-bit <Install_path>\Refinitiv\Refinitiv for Office\x.x.x\Office_x64 

 

There is no linking, presentation tools, or deal analytics package. 

Workspace add-in 
The Refinitiv Workspace - Excel (Workspace ribbon) add-in changes are listed in the table below: 

Version Add-ins 

1.22 No changes 

1.21 =RDP.FxSwpToSwp() 

=RDP.FxDepToSwp() 

=RDP.FxSwpToDep() 

=RDP.FxSpot() 

=RDP.FxInfo() 

=RDP.FxZcToFra()  

=RDP.DateAdjToWD() 

=RDP.DateCountPeriods() 

=RDP.DateFindDate() 

=RDP.DateIsWD() 

=RDP.DateLastWD() 

=RDP.DateListHolidays() 

=RDP.Adinterp() 

1.20 No changes 

1.19 No changes 

1.18 No changes 

1.17 No changes 

1.16 =RDP.Publish() 

https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/add-ins-system-requirements.pdf
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/add-ins-workspace-installation-guide.pdf
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/add-ins-workspace-lite-installation-guide.pdf
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/add-in-release-notes.pdf
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Version Add-ins 

=RtContribute()76 

=RDP.PublishChain() 

=RtContributeChain() 

=DSCHART() 

1.15 No changes 

1.14 No changes 

1.13  No changes 

1.12 =TRAggregate() 
=RDP.Aggregate() 
=RDP.Analytics() 
=RDP.Data() 
=RDP.HistoricalPricing() 
=RDP.Price() 

1.11 =RDP.Today() 
=RDP.Now() 

1.10 =RtToday() 
=RtNow() 

1.9 Refinitiv.EmbeddedApplication (financial chart) 
=DSGRID() 
=Thomson.Reuters.AFOSpreadSheetFormulas.DSGRID() 
=RDP.Search() 

1.8 =RHistory() 
=RtGet() 
=TR() 

 

 
 
76  See Contributions (RtContribute) in the Appendix L: Known issues section. 
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Appendix G: Configuring Real-Time Data 
products 
This appendix provides an overview of the configuration requirements to establish a connection between Workspace and a local 
LSEG Real-Time Advanced Distribution Server (formerly ADS).  

In this section 

• Network requirements 

• Real-Time product version compatibility 

• Connection configuration 

• Workspace configuration 

• Managing hosted connections 

• Subscription limits 

• Conflation management 

• Connection information in About LSEG Workspace 

• Contributions 

• Specific use cases 

Network requirements  

Bandwidth  Workspace Desktop: 175 kb/s  

Workspace Web: 100 kb/s  

Firewall   *.refinitiv.com   

*.refinitiv.biz  

*.refinitiv.net  

Ports  1500077  

443  

  

The Bandwidth figures were calculated based on the bandwidth used over a several-week period using typical Investment Banking 
and Wealth Advisor watchlists. Actual bandwidth utilization will vary based on the actual number of symbols in your environment 
and the frequency at which those instruments update. 

Real-Time product version compatibility 
For LSEG Workspace, the following Real-Time product versions are recommended: 

Product Version 

Real-Time Advanced Distribution Server78 3.6 or higher (3.7 or higher for RWF data)  

LSEG Real-Time Data Access Control System (formerly DACS) 7.2 or higher 

 
 
77  For streaming Local Real-Tine Distribution System connections only, using the default port. 
78  For additional information regarding the Real-Time Advanced Distribution Server encryption capabilities offered by version 3.8, see the Local 

connection security parameters section. 
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Connection configuration  
WebSocket is an industry-standard, bidirectional communication protocol that sends data between client and server by reusing the 
established connection channel. The connection is kept alive until terminated by either the client or the server.   

⚠ Raw TCP IP (for example, RSSL) connections are not supported by LSEG Workspace.  

Protocol support  
LSEG supports79 the following protocols for use with LSEG Workspace. However, we recommend RWF80 over secure WebSocket. 

Option  Data 
format 

Scheme ANSI page 
support 

Price 
formatting 
support81 

RTDS or 
ADS 3.7 or 

higher 

Reduced 
CPU use 

OpenFin 
compatible 

RWF over secure WebSocket82  RWF rwf+wss:// Yes Yes Yes Yes Yes 

RWF over WebSocket  RWF rwf+ws:// Yes Yes Yes Yes No 

JSON over secure WebSocket  JSON wss:// No No No No Yes 

JSON over WebSocket  JSON ws:// No No No No No 

Local connection security parameters 
Real-Time Advanced Distribution Server version 3.8 supports the use of simultaneous encrypted and unencrypted connections, 
without impact to the performance or resource usage of Workspace, to the same server.  

That is, it supports connection through multiple ports, where one or more ports are configured as encrypted, and one or more ports 
are configured as unencrypted.  

For further information about WebSocket configuration options, including the configuration parameters in the sections below, refer 
to the WebSocket Connection chapter of the Real-Time Advanced Distribution Server System Administration Guide. This can be 
found in the Real-Time Advanced Distribution Server section on MyAccount. 

Connections secured with certificates 

Certificates are used to encrypt data sent between the Real-Time Advanced Distribution Server and the end user.  

Certificates require the following parameters83 (highlighted in bold) to be added to the Real-Time Advanced Distribution Server 
configuration (.cnf) file:  

*ads*allowWSConnections : true  
*ads*${port}*connectionType : 1  
*ads*${port}*serverCert : <certificate path>  
*ads*${port}*serverPrivateKey : <private key path>  

At a high level, to secure your Real-Time Advanced Distribution Server to Workspace connections using a certificate, you need to 
do the following:  

1. Create or add a signed certificate on your Real-Time Advanced Distribution Server and configure its location in your 
distribution.cnf file. For example: 

ads*${port}*serverCert : /opt/refinitiv/home/radmin/Certs/Certificate.crt 
ads*${port}*serverPrivateKey : /opt/refinitiv/home/radmin/Certs/id_rsa.key.pem  

 
 
79  Currently, the LSEG Real Time Managed Distribution System does not support secured and encrypted connections. 
80  A binary protocol, similar to RSSL in Eikon 4.0. See also Refinitiv Wire Format, in the Glossary appendix. 
81  Fractions and trailing zeroes for price values. 
82  For requests to LSEG, the Hosted Market Data System (HMDS) connection uses rwf+wss:// protocol. 
83  Refer to the WebSocket Connection > Advanced configuration section in the Real-Time Advanced Distribution Server System 

Administration Guide 

https://myaccount.lseg.com/content/dam/myrefinitiv/products/9936/en/Technical/657626.pdf
https://myaccount.lseg.com/content/dam/myrefinitiv/products/9936/en/Technical/657626.pdf
https://myaccount.lseg.com/content/dam/myrefinitiv/products/9936/en/Technical/657626.pdf
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2. In the Real-Time Advanced Distribution Server configuration (.cnf) file, enable WebSocket encryption by amending the 
connectionType84 parameter. For example: 

ads*${port}*connectionType : 1 

3. To commit the changes, restart the Real-Time Advanced Distribution Server daemon. 

4. Using the Workspace Administration Tools app, change the protocol from ws to wss. 

For further information, see the Administration Tools Configuration Guide. 

Self-signed certificates   

While not recommended as an approach, self-signed certificates can be used to establish secured connection between the Real-
Time Advanced Distribution Server and the end user. To do this, the certificate should be installed on every user machine under 
Root certificates.  

Non-secured connections 

For no-secured connections, the following settings are required: 

*ads* allowWSConnections : true  
*ads*${port}*connectionType : 0  

Data compression  
The RWF and JSON WebSocket protocols support ZLib compression only. However, for compression to be used, in the Real-Time 
Advanced Distribution Server configuration, the following parameter must be set: 

*ads*${port}*forceRsslCompression : True 

 LZ4 compression is not supported by WebSocket.  

For further information about compression, see the Compression parameters and sections of the Real-Time Advanced 
Distribution Server System Administration Guide. 

Port configuration  
You can customise ports in Real-Time Advanced Distribution Server85.  

Connection  Port86 

Non-secured   15000 

Secured (ADS)  15000 

Secured (LSEG)  443 

Additional configuration parameters  
Real-Time Advanced Distribution Server LAN and Host devices running on the Real-Time Distribution System require a centralized 
Real-Time Advanced Distribution Server configuration (.cnf) file that you generate using the tconfig utilities. For further information, 
see the Configuring the LAN and Host Servers chapter of the Real-Time Advanced Distribution Server System Administration 
Guide. 

 
 
84  Determined by the connectionType parameter, where: 

• 1 indicates the connection is encrypted and certificates are required. 
• 0 indicates the connection is unencrypted. 

 Additional information can be found in the WebSocket Connection > Advanced configuration section of the Real-Time Advanced 
Distribution Server System Administration Guide. 

85  For further information, refer to the WebSocket Connection > Basic Configuration section of the Real-Time Advanced Distribution Server 
System Administration Guide. 

86  Ports can be customised in Real-Time Advanced Distribution Server. 

https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/administration-tools-configuration-guide.pdf
https://myaccount.lseg.com/content/dam/myrefinitiv/products/9936/en/Technical/657626.pdf
https://myaccount.lseg.com/content/dam/myrefinitiv/products/9936/en/Technical/657626.pdf
https://my.refinitiv.com/content/dam/myrefinitiv/products/9601/en/Technical/640424.pdf
https://my.refinitiv.com/content/dam/myrefinitiv/products/9601/en/Technical/640424.pdf
https://myaccount.lseg.com/content/dam/myrefinitiv/products/9936/en/Technical/657626.pdf
https://myaccount.lseg.com/content/dam/myrefinitiv/products/9936/en/Technical/657626.pdf
https://myaccount.lseg.com/content/dam/myrefinitiv/products/9936/en/Technical/657626.pdf
https://myaccount.lseg.com/content/dam/myrefinitiv/products/9936/en/Technical/657626.pdf
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Configuring additional servers 
To allow access to different data feeds simultaneously, Workspace can be enabled to connect to additional servers. Up to eight 
additional LSEG Real-Time Advanced Distribution Servers can be added to a custom configuration.  

This is done by using the Streaming > Servers panel of the Configuration Manager or by using the following statement, where:  

• <n> is a number between 1 and 8 

• <server 1>, <server 2> and <server n> are the servers defined for initial connection and failover purposes (see the 

example, below) 

"EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.<n>": "[\"<server 1>",\"<server 2>",\"<server n>"]" 

 Additional servers work only if the main (primary) server connects to one of the defined servers successfully. 

For example: 

/*  
Each connection can have more than one URL, where each subsequent URL acts as a failover for 
the specific server 
*/ 
// Main server 
// 
"EIKON.STREAMING.API.LOCAL.SESSIONS": 
"[\"ws://ads01:15000/WebSocket\",\"ws://ads02:15000/WebSocket\",\"ws://ads02:15001/WebSocket\
"]", 
// 
// Additional server 
// 
"EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.1": 
"[\"ws://example01:15000/WebSocket\",\"ws://example02:15000/WebSocket\",\"ws://example03:1500
1/WebSocket\"]" 

License requirements 
To establish a successful connection between the Real-Time Advanced Distribution Server and the end user, the Snapshot batch and 
dynamic view requests (SNAP_AND_DYNAMIC_VIEW) capability license is required.  

For further information regarding this license, contact your LSEG Account Team. 

Workspace configuration 
By default, LSEG Workspace retrieves streaming data from the 
Common Platform hosted streaming servers (HMDS). However, for 
users wanting to connect Workspace to retrieve data from their own 
streaming sources the following settings can be defined in a shared 
settings JSON file. This allows administrators to share these settings 
between users.  

The settings discussed in this section can also be managed at an 
individual Workspace Desktop level, using the Configuration Manager.  

For further information on: 

• Workspace settings, refer to the Settings section of Appendix G: 
Shared configuration in this guide. 

• Configuration Manager, refer to the Configuring Workspace 
section of this guide.  

⚠ To avoid syntax errors, it is recommended to generate the configuration using the Configuration Manager. 

The following is an example of a Workspace configuration file where the parameters are discussed in the cross-referenced 
sections: 

{  

• Falling back to delayed RICs 
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  “EIKON.STREAMING.API.__CORE__.PLUGINS.FALLBACK.DELAYED.ENABLED”: “true”, 

• Local Real-Time Advanced Distribution Server configuration 

  "EIKON.STREAMING.API.LOCAL.ENABLE": "true",  
  "EIKON.STREAMING.API.LOCAL.SESSIONS": 
"[\"rssl://ads01.example.com:14002\",\"ws://ads01.example.com:15000/WebSocket\",\"rssl://ad
s02.example.com:14002\",\"rwf+wss://ads02.example.com:443/WebSocket\"]",  

• Failover to hosted connection 

  "EIKON.STREAMING.API.LOCAL.ALLOWHOSTEDFALLBACK": "false",  

• Load balancing 

  "EIKON.STREAMING.API.LOCAL.LOADBALANCING": "random",  

• Real-Time Data Access Control System configuration settings 

  "EIKON.STREAMING.API.LOCAL.DACS.USERNAME": "my-dacs-username",  
  "EIKON.STREAMING.API.LOCAL.DACS.POSITION": "localhost/127.0.0.1",  
  "EIKON.STREAMING.API.LOCAL.DACS.FORCECASE": "uppercase",  
  "EIKON.STREAMING.API.LOCAL.DACS.APPLICATIONID": "56",  

• DPRM configuration 

  "EIKON.STREAMING.API.LOCAL.DACS.DPRM.DELAY": "20000",  
  "EIKON.STREAMING.API.LOCAL.DACS.DPRM.INTERVAL": "43200000",  
  "EIKON.STREAMING.API.LOCAL.DACS.DPRM.PORT": "8302",  
  "EIKON.STREAMING.API.LOCAL.DACS.DPRM.SERVERS": "[\"dacs01\",\"dacs02\",\"dacs03\"]",  

• Streaming sources 

  "EIKON.STREAMING.API.LOCAL.DEFAULTSOURCE": "ELEKTRON",  
  "EIKON.STREAMING.API.LOCAL.DESKTOP.ALIASES": 
"{\"ATS_GLOBAL_1\":[\"A\",\"T\",\"S\"],\"IDN_SELECTFEED\":[\"I\"]}",  
  "EIKON.STREAMING.API.LOCAL.OFFICE.ALIASES": 
"{\"ATS_GLOBAL_1\":[\"ATS\",\"A\"],\"IDN_SELECTFEED\":[\"I\"]}",  

• Disabling contribution 

  "EIKON.STREAMING.API.LOCAL.DISABLEDCONTRIBUTIONSOURCES": 
"[\"ATS_GLOBAL_1\",\"NO_CONTRIB_ALLOWED\"]",  

• Server connection strings 

  "EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.1": 
"[\"rssl://add01.example.com:14002\",\"ws://add01.example.com:15000/WebSocket\"]",  
  "EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.2": 
"[\"ws://add02.example.com:15000/WebSocket\"]",  
  "EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.3": 
"[\"rwf+ws://add03.example.com:15000/WebSocket\",\"rwf+ws://add03-
2.example.com:15000/WebSocket\"]"  
 }  

Falling back to delayed RICs 
If users are not entitled to Real-Time RIC information, this setting can be defined in the Workspace shared configuration (.json) file 
using the default value, true 87. In this case, Workspace will automatically request data from the corresponding delayed RIC. 

Setting EIKON.STREAMING.API.__CORE__.PLUGINS.FALLBACK.DELAYED.ENABLED 

Default value true 

 

This can also be activated through the Settings option. To do so: 

 
 
87  In this circumstance, if set to disabled, Workspace will not show any data. 
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1. Select WS > Settings, to open the Settings app. 

2. From the side menu panel, select Workspace. 

3. In the Workspace Settings panel, select the Automatically show delayed data if real-time data is not available checkbox. 

Local Real-Time Advanced Distribution Server configuration 
By defining this setting as true, you instruct LSEG Workspace to try to connect to any configured local Real-Time Advanced 

Distribution Server. 

Setting EIKON.STREAMING.API.LOCAL.ENABLE 

Default value false 

Failover to hosted connection 
By defining this setting as true, when Workspace fails to connect to the first Real-Time Advanced Distribution Server connection, it 

attempts to connect to the next configured connection, if one is available. If none of the Real-Time Advanced Distribution Server 
connections manage to connect successfully, Workspace attempts to connect to LSEG hosted servers. 

Setting EIKON.STREAMING.API.LOCAL.ALLOWHOSTEDFALLBACK 

Default value true 

  

This behaviour can be disabled by setting the value to false. In which case, Workspace shows no data. 

After connecting to a hosted server, Workspace will not attempt to reconnect to a local Real-Time Advanced Distribution Server 
unless it gets restarted manually.  

Load balancing  
The load balancing setting allows you to disable the default priority order of Real-Time Advanced Distribution Server connections and 
randomly connect to one of the connections when Workspace starts. This is used to distribute the load on Real-Time Advanced 
Distribution Server connections equally.  

For example: There are four server configurations and a total of 100 users. If the value is set to random, on average, each server 

will have 25 connected users.  

Setting EIKON.STREAMING.API.LOCAL.LOADBALANCING 

Default value ordered 

Server connection strings 
To establish a WebSocket connection with Real-Time Advanced Distribution Server, Workspace requires a connection string 
comprised of Protocol, Hostname/IP, and Port number. The value is a comma separated list of ordered connection strings.  

Workspace supports up to eight (8) additional simultaneous Real-Time Advanced Distribution Server connections, together with the 
primary connection. However, it requires the primary connection to connect successfully beforehand.  

Both the primary and additional connections can have unlimited fallback connection strings. For further information about 
configuring these settings, see the Configuring additional servers section. 

Primary connection 

Setting EIKON.STREAMING.API.LOCAL.SESSIONS 

Value (array) ["ws://ads01.example.com:15000/WebSocket","wss://ads02.example.com:14002/WebSocket 
","rwf+wss://ads02.example.com:443/WebSocket"]  
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Additional connections 

Setting EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.1 

Value (array) For example: 
["ws://ads01.example.com:15000/WebSocket","wss://ads02.example.com:14002/WebSocket 
","rwf+wss://ads02.example.com:443/WebSocket"]  

Streaming sources 
You can use the following settings to define primary and secondary streaming sources for Workspace applications and add-ins. 

Primary or default source 

The primary streaming source setting allows you to customize the default streaming source used in LSEG Workspace applications. 
The primary source should be trade-safe88 and sourced from LSEG Elektron real-time data: 

Setting EIKON.STREAMING.API.LOCAL.DEFAULTSOURCE 

Default value IDN_RDF 

 

This source is available in:  

• LSEG Workspace, as the Q key letter. and  

• Microsoft365, as the IDN alias.  

• By default, LSEG Workspace assumes that the default source is named IDN_RDF. As such, by customizing this setting, you 

can change the default streaming source to use. 

Desktop key-letter aliases 

By customizing this setting, you can define additional key-letters for sources provided by the local LSEG Real-Time Distribution 
System. These key-letters will only be visible in LSEG Workspace applications (Quote, Monitor, and so on).  

Setting EIKON.STREAMING.API.LOCAL.DESKTOP.ALIASES 

Value (array) {"ATS_GLOBAL_1":["A","T","S"],"IDN_SELECTFEED":["I"]} 

 

 LSEG Workspace Desktop will only display single letter aliases, known as key-letters. Multi-letter aliases are used in the 
Microsoft Office Workspace add-ins. 

This setting should be defined to a JSON-encoded object. These object properties are real source names, and their values are a 
JSON-encoded array of key-letters. 

Office aliases 

By customizing this setting, the user can define additional aliases for sources provided by the local LSEG Real-Time Distribution 
System. These aliases will only be visible in the Microsoft365 Workspace add-ins.  

Setting EIKON.STREAMING.API.LOCAL.OFFICE.ALIASES 

Value (array) {"ATS_GLOBAL_1":["ATS","A"],"IDN_SELECTFEED":["I"]} 

Disabling contribution  
Using this setting, you can list sources on your local LSEG Real-Time Distribution System (formerly TREP) to which they are not 
allowed to contribute. As such, any attempt at contributing data on the sources listed under this setting will be rejected.  

By default, contribution is allowed on all sources.  

Setting EIKON.STREAMING.API.LOCAL.DISABLEDCONTRIBUTIONSOURCES  

 
 
88  For further information, refer to the Trade-safe requirements section. 
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Value [“ATS_GLOBAL_1”,"NO_CONTRIB_ALLOWED"]  

Real-Time Data Access Control System configuration settings 
The following settings are used to define the authentication settings for local streaming servers. 

Username and letter case 

The USERNAME setting allows you to customize the Real-Time Data Access Control System (formerly DACS) username that is 
used to authenticate to your local streaming servers. For example, "my-dacs-username".  

If this is not set, LSEG Workspace will use the local operating system username.   

Setting EIKON.STREAMING.API.LOCAL.DACS.USERNAME 

Default value Username taken from the operating system 

 

The FORCECASE setting allows you to override the letter case of the defined Real-Time Data Access Control System username to 
be:  

• Upper case (ABC123), using the string “uppercase”, or  

• Lower case (abc123), using the string "lowercase" 

⚠ Authentication in the Real-Time Data Access Control System is case-sensitive. So, caution is advised should you intend to use 
this setting, as any mixed case usernames will be overridden and will no longer match. 

Setting EIKON.STREAMING.API.LOCAL.DACS.FORCECASE 

Default value The case of the username that is entered using the USERNAME setting (discussed above) is not changed. 

Position 

This setting allows you to customise the Real-Time Data Access Control System position that is used to authenticate to local 
streaming servers. For example, "localhost/127.0.0.1". 

Setting EIKON.STREAMING.API.LOCAL.DACS.POSITION 

Default value If not set, to authenticate, Workspace uses the local hostname followed by a local IP address. If no such 
address is found, 127.0.0.1 is used. 

Application ID  

This setting allows you to customise the Real-Time Data Access Control System application ID that is used to authenticate to local 
streaming servers. LSEG Workspace uses the value of "56".   

Setting EIKON.STREAMING.API.LOCAL.DACS.APPLICATIONID 

Default value 56 
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DPRM configuration89 
For those Workspace desktop customers who want to use the optional DPRM service in their local LSEG Real-Time Distribution 
System, the settings in the following sections can be added to the <override_settings>.json file. 

It is highly recommended to use DACS Permission Synchronization for Workspace is recommended – rather than the DPRM 
service - to prevent misconfiguration or permission issues between the Delivery Platform (formerly RDP) and local LSEG Real-
Time Distribution System. 

⚠ Warning: DPRM is supported on Workspace Desktop only and is not supported on LSEG Workspace for OpenFin.  

The following is an example of DPRM configuration settings. The parameters are discussed over the following sections: 

"EIKON.STREAMING.API.LOCAL.DACS.DPRM.PORT": "8261", 
"EIKON.STREAMING.API.LOCAL.DACS.DPRM.INTERVAL": "43200000",                
"EIKON.STREAMING.API.LOCAL.DACS.DPRM.DELAY": "50000",  
"EIKON.STREAMING.API.LOCAL.DACS.DPRM.SERVERS": "[\"dacs01\",\"dacs02\",\"dacs03\"]" 

Entitlement retrieval  

The PORT setting allows you to specify the port, through which the entitlements used for DPRM are retrieved: 

Setting EIKON.STREAMING.API.LOCAL.DACS.DPRM.PORT 90 

Mode In general, the port should be set to either of the following modes91:  

• 8261 - Permission proxy mode, or  

• 8302 - Permission service mode92 

 

The INTERVAL allows you to set the interval, in milliseconds, between each reconciliation of DACS entitlements with the DPRM 
service:  

Setting EIKON.STREAMING.API.LOCAL.DACS.DPRM.INTERVAL 

Default value 86400000 (24 hours) 

 

The DELAY setting allows you to set the delay, in milliseconds, between Workspace initialization after login and the reconciliation 
of DACS entitlements with the DPRM service.  

Setting EIKON.STREAMING.API.LOCAL.DACS.DPRM.DELAY 

Default value 60000 (60 seconds) 

 

Permission service mode server list 

This allows you to specify a list of servers to use for DPRM, when running permission service mode only. This setting is defined as 
a JSON-encoded array of permission service hostnames. For example: "[\"dacs01\",\"dacs02\",\"dacs03\"]" 

Setting EIKON.STREAMING.API.LOCAL.DACS.DPRM.SERVERS 

Port Set for permission service mode only (port 8302).93 

 

 
 
89  In Workspace 1.23, there is a known issue with the DPRM service that affects a small minority of installations. This has been fixed in versions 

from Workspace 1.24. 
90  The EIKON.STREAMING.API.LOCAL.DACS.DPRM.PORT parameter is mandatory. 
91  If not set to one of these values, DACS synchronization is not performed. 
92  In permission proxy mode, the list of servers in the EIKON.STREAMING.API.LOCAL.SESSIONS setting is used. 
93  If not set, the list of servers defined in the EIKON.STREAMING.API.LOCAL.SESSIONS setting is used. 

https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/W%20O%20R%20K%20S%20P%20A%20C%20E/E%20L%20E%20C%20T%20R%20O%20N/Workspace%20IT%20Managed%20Installation%20Guide/lseg-workspace-1.24-it-managed-installation-guide%20-%20124.03.docx#_DPRM_connection_issue
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Additional dumpConfig statements 
When using the –dumpConfig parameter with the Workspace executable, the following additional parameters are added to the 

logs folder.  

"EIKON.INTRANET_OVERRIDE.FALLBACKFILE": "",  

"EIKON.LOG.REDIRECTCONSOLE": "true", Using this statement, you can capture all messages from the 
console and add them to Workspace logs. All captured 
console messages are prefixed by [console]. 

However, if capturing these messages impacts performance, 
you can disable this capability using the false value. 

"EIKON.PLATFORM.ENVIRONMENT": "prod", The platform server environment. Possible values: 

• alpha 
• beta 
• prod(uction) 

"EIKON.STREAMING.API.LOCAL.DESKTOP.EXTENDED.ALIASES
.ENABLE": "false", 

 

"kobra.objects.news.newsapp_showdebuginfo": "false",  

"WORKSPACE.LOGIN.CIAM": "false"  

Workspace for OpenFin  
Workspace for OpenFin has the same capabilities in terms of real-time configuration as Workspace Desktop. However, the 
differences between the products are summarized below. 

Workspace for OpenFin:  

• Can only be configured using Workspace Admin Tools, where configurations are hosted at LSEG side.  

• Does not support DPRM, as only Secured WebSocket protocols will be supported, including rwf+wss:// and wss://  

For further information, refer to the OpenFin Installation and Configuration Guide. 

Managing hosted connections  
By default, Workspace is configured to connect to LSEG hosted servers to retrieve real-time data.  

Setting EIKON.STREAMING.API.LOCAL.ENABLE  

Default value False 

https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/openfin-installation-and-configuration-guide.pdf
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Subscription limits  
For hosted users, the default subscription limit for RICs on 
Workspace Desktop is 250094 and 1000 for Workspace Web.  

The limit applies at user level, across all devices, platforms, and 
apps. This means that for a single app, such as Monitor, it may not 
be possible to achieve the maximum number of RICs, as some will 
be used by other apps or services.  

There is no limit to subscriptions on Real-Time Advanced Distribution 
Server connections, unless defined by local administrators.  

The Streaming panel of the About LSEG Workspace dialog box, 
opposite, contains information about real-time data sources, RICs 
used (subscriptions), and any other feeds provided through a local 
LSEG Real-Time Distribution System.  

Conflation management  
This section covers the definition of conflation settings on Real-Time products and on Workspace Desktop. 

Depending on the use case, conflation can be applied both on your Real-Time Advanced Distribution Server and Workspace 
Desktop, to achieve minimum bandwidth and resources usage.  

Real-Time conflation settings 
Conflation at Real-Time Advanced Distribution Server level is preferred to reduce the conflation processing on user machines. This 
will also reduce the bandwidth between a Real-Time Advanced Distribution Server and the end user.  

For Real-Time Managed Distribution Services, data is conflated to 300ms on the server side. 

For further information, refer to the Conflation > Configuration section in the Real-Time Advanced Distribution Server System 
Administration Guide. 

Workspace conflation settings  
For feeds that use a more frequent conflation rate than 300ms, by default, Workspace Desktop will change the rate to 
300ms. However, this does not apply to all apps, as certain apps use custom conflation or trade safe data.  

While conflating, only the latest record is displayed from the conflation timeframe.  

The conflation can be increased to 1500ms, 3000ms, or 6000ms to have less frequent updates on Workspace. It is, however, 
recommended to configure conflation on your Real-Time Advanced Distribution Server, considering all users require the same 
conflation level.  

Trade-safe requirements  

In Workspace, Time Series requires trade-safe data. That is, when trade-safe conflation is enabled, the Real-Time Advanced 
Distribution Server does not conflate trade-type updates. So, any pending updates for the item are sent, followed by the non-
conflatable update. 

For further information, refer to the Trade-safe conflation section of the Conflation chapter in the Real-Time Advanced 
Distribution Server System Administration Guide. 

Configuration manager  

The Workspace Configuration Manager facility provides the flexibility to apply conflation at single user and machine level, or to 
many users through a shared configuration file.   

Administration panel  

The Administration Panel app can be used to apply conflation configuration at company level.  

The app also supports an option to manage Conflation for the Blended Order Books app.  

 
 
94  This can be extended to 5000 or 10000 by obtaining additional licenses or products from LSEG. 

https://myaccount.lseg.com/content/dam/myrefinitiv/products/9936/en/Technical/657626.pdf
https://myaccount.lseg.com/content/dam/myrefinitiv/products/9936/en/Technical/657626.pdf
https://myaccount.lseg.com/content/dam/myrefinitiv/products/9936/en/Technical/657626.pdf
https://myaccount.lseg.com/content/dam/myrefinitiv/products/9936/en/Technical/657626.pdf
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Connection information  
The About LSEG Workspace option provides information about the status of connections at an individual user level. To access 
this option: 

• Select Help > About LSEG Workspace 

For further information about this option, refer to the About LSEG Workspace dialog section of this guide. 

Contributions  
The Contributions Channel allows data to be contributed to a Real-Time Advanced Distribution Server or LSEG directly. This data 
can then be consumed across Workspace products.  

LSEG Elektron contribution feeds  
By default, contribution to LSEG95 is not enabled and approval from LSEG is required to contribute data. Additionally, you will 
require assistance from LSEG to setup and configure your systems. 

The feeds used to contribute data to LSEG include the following:  

• DDS_TRCE  

• ELEKTRON_CON  

• TRC  

Contributions to a local Real-Time Advanced Distribution Server  
Contribution to your local Real-Time Advanced Distribution Server uses the pre-configured protocol for requests. However, 
contribution can be disabled for specific feeds using the following array setting:  

Settings EIKON.STREAMING.API.LOCAL.DISABLEDCONTRIBUTIONSOURCES 

Value [\"ATS_GLOBAL_1\",\"NO_CONTRIB_ALLOWED\"]  

 
 
95  Contribution to LSEG uses the rwf+wss:// protocol. 
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Appendix H: Shared configuration  
This appendix covers the creation and definition of a shared configuration file, and introduces the priority order applied to all types 
of configuration files. 

Configuration override 
order 
The illustration below shows the override order 
for configuration settings96, where commands 
issued using the command line have the highest 
level of priority: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Creating a shared 
configuration file 
Once you have made your settings using the 
Configuration Manager dialog, do the following: 

1. click Export  

2. Use the Save As dialog to define a file name 
and location 

Settings 
The following table contains a shared configuration file example, showing where the setting is found, and the selection or entry that 
was made in the example: 

Setting example Description\Source 

{  

Configuration Manager > Network menu  

"EIKON.CONNECTION.MODE": "private", Options:  

• Internet 

• Private network  

 
 
96  The Admin level shared configuration file is created using the Administration Panel tool. For further information, refer to the Administration 

Panel Configuration Guide. 
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https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/administration-panel-configuration-guide.pdf
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/administration-panel-configuration-guide.pdf
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Setting example Description\Source 

Configuration Manager > Advanced menu   

"REFINITIV.WORKSPACE.RUN_ABOVE_NORMAL_PRIORITY": 
"true", 

Option: 

• Run at the Highest Available Process Priority Level  

Configuration Manager > Printer menu   

"REFINITIV.WORKSPACE.TRADING.PRINTER_NAME": 
"Microsoft Print to PDF", 

Options: 

• Configured printers97 

• Fax 

• Microsoft Print to PDF  

• Microsoft XPS Document Writer 

• OneNote (Desktop) 

• OneNote for Windows 

Configuration Manager > Shared Configuration menu 

"EIKON.INTRANET_OVERRIDE.ENABLED": "true", Options: 

• Use a shared configuration 

"EIKON.INTRANET_OVERRIDE.URL": "C:\\RWTest\\Shared 
config\\MAIN.json", 

• Location path or URL (defined as C:\\RWTest\\Shared 
config\\MAIN.json) 

• This can be multiple location paths or URLs, delimited 
using a semi-colon (;) 

Configuration Manager > Client SSO menu  

"CLIENTSSO_URL.ENABLED": "true", Options: 

• Use a client SSO  

"CLIENTSSO_URL": "https:\\myapps.testsso.com", • Thomson Reuters (defined as 
https:\\myapps.testsso.com) 

"CLIENTSSO_REFINITIV_URL": 
"https:\\myapps.testsso.com", 

• Refinitiv (defined as https:\\myapps.testsso.com) 

Configuration Manager > Streaming menu  

"EIKON.STREAMING.API.LOCAL.ENABLE": "true", Stream Data Retrieval options: 

• From Refinitiv 

• From a local LSEG Real-Time Advanced Distribution 
Server 98   

"EIKON.STREAMING.JETQUOTES.DESKTOP.CONFLATION.ENABL
E": "true", 

Streaming Conflation option: 

• Activate Conflation Rate 

"EIKON.STREAMING.JETQUOTES.DESKTOP.CONFLATION": 
"3000", 

• Conflation rate value drop down (3 seconds selected) 

 
 
97  Network or connected directly 
98  For further information about configuring Real-Time data, refer to Appendix F: Configuring Real-Time Data products. 

https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/W%20O%20R%20K%20S%20P%20A%20C%20E/E%20L%20E%20C%20T%20R%20O%20N/Workspace%20IT%20Managed%20Installation%20Guide/lseg-workspace-1.24-it-managed-installation-guide%20-%20124.09%20d02.docx#_Appendix_E:_Refinitiv
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Setting example Description\Source 

Configuration Manager > Streaming > Servers menu99 

"EIKON.STREAMING.API.LOCAL.SESSIONS": 
"[\"wss:\\test-ads-
sharedconfig.com:15000\WebSocket\"]", 

LSEG Real-Time Advanced Distribution Server options: 

• Protocol (selected wss:\\) 

• Hostname or IP (defined as test-ads-
sharedconfig.com) 

• Port (defined as 15000) 

For additional servers that may be configured in the shared 
configuration file only, see the Streaming protocols section. 

Configuration Manager > Streaming > DACS menu   

"EIKON.STREAMING.API.LOCAL.DACS.USERNAME": 
"permit_all_exchanges", 

Options: 

• Username (defined as permit_all_exchanges) 

"EIKON.STREAMING.API.LOCAL.DACS.POSITION": 
"%USERDETAILS.LASTNAME%_%USERDETAILS.UUID", 

• Position (defined as 
%USERDETAILS.LASTNAME%_%USERDETAILS.UUID) 

Configuration Manager > Streaming > Feeds menu  

"EIKON.STREAMING.API.LOCAL.DEFAULTSOURCE": 
"IDN_RDF_2", 

Main Feed options: 

• Feed Name (defined as IDN_RDF_2) 

• Key Letter(s) (set automatically to Q) 

• Alias(es) (set automatically to IDN) 

"EIKON.STREAMING.API.LOCAL.DESKTOP.ALIASES”: 
“{\”Test Internal feed 1\”:[\”Z\”]}”, 

Other Local Feeds options: 

• Feed Name (defined as Test Internal feed 1) 

• Key Letter(s) (defined as Z) 

"EIKON.STREAMING.API.LOCAL.DESKTOP.ALIASES”: 
“{\”Test Internal feed 1\”:[\”INF_1\”]}”, 

• Feed Name (defined as Test Internal feed 1) 

• Alias(es) (defined as INF_1) 

“EIKON.STREAMING.API.LOCAL.DISABLEDCONTRIBUTIONSOUR
CES”: "[\"ATS_GLOBAL_1\",\"NO_CONTRIB_ALLOWED\"]" 

By default, contribution is allowed on all sources. This setting 
is used to list sources on your local LSEG Real-Time 
Advanced Distribution Server100 where contributions are not 
allowed. 

Any subsequent attempt to contribute data to one of the listed 
sources is then rejected. 

This setting should be defined to a JSON-encoded array, 
where each array entry is a real source name. For example: 

["ATS_GLOBAL_1","NO_CONTRIB_ALLOWED"] 

Configuration Manager > Other menu   

"EIKONPROTOCOL.ISDEFAULTAPPLICATION": "true" Select the app that is used to open LSEG links: 

• LSEG Workspace  

• Eikon 4 

}  

 

For further information on the creation of a shared configuration file, refer to the Configuring Workspace section. 

 
 
99  Up to eight additional servers can be configured. For further information, refer to the Configuring multiple servers section. 
100  For further information about configuring Real-Time data, refer to Appendix F: Configuring Real-Time Data products. 

https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/W%20O%20R%20K%20S%20P%20A%20C%20E/E%20L%20E%20C%20T%20R%20O%20N/Workspace%20IT%20Managed%20Installation%20Guide/lseg-workspace-1.24-it-managed-installation-guide%20-%20124.09%20d02.docx#_Appendix_E:_Refinitiv
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Streaming protocols 
In all supported versions of Workspace101, additional Refinitiv Wire Format protocols for LSEG Real-Time Advanced Distribution 
Server100 may be configured. This is done by using Configuration Manager or, manually, in your shared configuration JSON file:  

Protocol  Transport Example 

rwf+ws:\\ WebSocket rwf+ws:\\ads01.example.com:15000\WebSocket 

rwf+wss:\\ Secure WebSocket rwf+wss:\\ads01.example.com:443\WebSocket 

 

For example: 

["ws:\\ads01.example.com:15000\WebSocket","rwf+wss:\\ads02.example.com:443\WebSocket"] 

 The default LSEG Real-Time Distribution System port for WebSocket is 15000.  

Some proxy servers may not support (or have disabled support for) the WebSocket protocol, which may cause Workspace 
streaming-related features not to work. 

You must do the following:  

• For Internet, allow WebSocket connectivity *.refinitiv.com and *.refinitiv.net  

• For Delivery Direct, allow WebSocket connectivity to *.refinitiv.biz and *.refinitiv.net  

 

 
 
101  Workspace version 1.22 was the first release to support the new protocols. 
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Appendix I: Running a mass deployment 
You can deploy LSEG Workspace with your own mass deployment tool. To do so, follow the instructions, below: 

1. Download the Workspace Installer from the LSEG Workspace download page. The file has the following naming structure, 
where x.xx.xx is the version number: 

RefinitivWorkspace-installer_x.xx.xx.exe 

2. Create a config.json file   

For example:  

{ 
  "EIKON.CONNECTION.MODE": "private", 
  "EIKON.LOG.TRACELEVEL": "warn", 
  "REFINITIV.WORKSPACE.RUN_ABOVE_NORMAL_PRIORITY": "true", 
  "REFINITIV.WORKSPACE.TRADING.PRINTER_NAME": "Microsoft Print to PDF", 
  "EIKON.INTRANET_OVERRIDE.URL": "C:\\Workspace\\config.json", 
  "CLIENTSSO_URL.ENABLED": "true", 
  "CLIENTSSO_URL": "https:\\myapps.testsso.com", 
  "CLIENTSSO_REFINITIV_URL": "https:\\myapps.testsso.com", 
  "EIKON.STREAMING.API.LOCAL.ENABLE": "true", 
  "EIKON.STREAMING.API.LOCAL.SESSIONS": "[\"wss:\\test-ads-
sharedconfig.com:15000\WebSocket\"]", 
  "EIKON.STREAMING.API.LOCAL.DACS.USERNAME": "permit_all_exchanges", 
  "EIKON.STREAMING.API.LOCAL.DACS.POSITION": "%USERDETAILS.LASTNAME%_%USERDETAILS.UUID", 
  "EIKON.STREAMING.API.LOCAL.DEFAULTSOURCE": "IDN_RDF_2", 
  "EIKON.STREAMING.JETQUOTES.DESKTOP.CONFLATION.ENABLE": "true", 
  "EIKON.STREAMING.JETQUOTES.DESKTOP.CONFLATION": "3000", 
  "EIKONPROTOCOL.ISDEFAULTAPPLICATION": "true" 
} 

3. Prepare the installation command line. For further information about installation command line parameters, refer to Appendix 
C: Command line statements. 

4. Create an install script. For an example of an install script (install.cmd), see the Script examples section, below. 

5. Prepare a group of users and the configuration using the Workspace Client Administration Tools app. 

The Client Administration Tools app is a centralized administration portal. In a customer-managed environment, you can use it 
to manage configurations – such as connection type, streaming configuration, log level, and so on – and assign them to 
individual and groups of users within your organisation. This can also be done before installing Workspace.  

For more detailed information, refer to the Workspace Administration Tools Configuration Guide. 

6. Ensure all necessary files are in a shared location 

The following files must be in a common location: 

• RefinitivWorkspace-installer_x.xx.xx.exe  
• config.json  
• config_fallback.json (optional) 

• install.cmd  

7. Run the installation script using your deployment tool. 

 After installation, when users first log in, Workspace checks whether a configuration was assigned using the Client 
Administration Tools app and, if found, applies it. The user is then prompted to restart Workspace to apply the configuration.  

Script examples 
This section contains examples of the following scripts for LSEG Workspace: 

• Installation 

• Update 

• Rollback 

• Uninstallation 

https://www.lseg.com/en/data-analytics/products/workspace/download-workspace
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/administration-tools-configuration-guide.pdf
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Install (install.cmd) script example: 

@echo off 
:------ Identify the command's parameters to install the software 
SET VERSION=1.20.38 
SET REFINITIV_WORKSPACE_INSTALLER=C:\Workspace\RefinitivWorkspace-installer %VERSION%.exe 
SET REFINITIV_WORKSPACE_SHARED_CONFIG_FILE=C:\Workspace\config.json 
SET REFINITIV_WORKSPACE_SHARED_CONFIG_FALLBACK_FILE=C:\Workspace\config_fallback.json 
SET DEPLOYMENT_MODE=--machine-autoupdate-service 
SET REFINITIV_WORKSPACE_INSTALL_PATH=C:\rw\installpath 
SET REFINITIV_WORKSPACE_LOG_PATH=C:\rw_custpath\log 
SET REFINITIV_WORKSPACE_CACHE_PATH=C:\rw_custpath\cache 
SET REFINITIV_WORKSPACE_SHORTCUTS_PATH=C:\rw_custpath\shortcuts 
:: ----- Workspace Installation ------ 
"%REFINITIV_WORKSPACE_INSTALLER%" %DEPLOYMENT_MODE% --
sharedconfig="%REFINITIV_WORKSPACE_SHARED_CONFIG_FILE%;%REFINITIV_WORKSPACE_SHARED_CONFIG_FAL
LBACK_FILE%" --silent; 
:: "%REFINITIV_WORKSPACE_INSTALLER%" %DEPLOYMENT_MODE% --
sharedconfig="%REFINITIV_WORKSPACE_SHARED_CONFIG_FILE%;%REFINITIV_WORKSPACE_SHARED_CONFIG_FAL
LBACK_FILE% --installpath="%REFINITIV_WORKSPACE_INSTALL_PATH%" --
cachepath="%REFINITIV_WORKSPACE_CACHE_PATH%" --logpath="%REFINITIV_WORKSPACE_LOG_PATH%" --
shortcuts="%REFINITIV_WORKSPACE_SHORTCUTS_PATH%" ; 

Workspace update (update.cmd) script example: 

@echo off 
:------ Identify the command's parameters to install the software 
SET VERSION=1.21.365 
SET REFINITIV_WORKSPACE_INSTALLER=C:\Workspace\RefinitivWorkspace-installer %VERSION%.exe 
SET DEPLOYMENT_MODE=--machine-autoupdate-service 
:: ----- Workspace Software Update ------ 
"%REFINITIV_WORKSPACE_INSTALLER%" %DEPLOYMENT_MODE% --silent; 
:: "%REFINITIV_WORKSPACE_INSTALLER%" %DEPLOYMENT_MODE% --
sharedconfig="%REFINITIV_WORKSPACE_SHARED_CONFIG_FILE%;%REFINITIV_WORKSPACE_SHARED_CONFIG_FAL
LBACK_FILE% --installpath="%REFINITIV_WORKSPACE_INSTALL_PATH%" --
cachepath="%REFINITIV_WORKSPACE_CACHE_PATH%" --logpath="%REFINITIV_WORKSPACE_LOG_PATH%" --
shortcuts="%REFINITIV_WORKSPACE_SHORTCUTS_PATH%" ; 

Rollback (rollback.cmd) script example: 

@echo off 
:------ Identify the command's parameters to rollback the software 
SET REFINITIV_WORKSPACE_INSTALL_PATH=C:\Program Files\Refinitiv\Refinitiv Workspace 
:: ----- Workspace Uninstallation ------ 
"%REFINITIV_WORKSPACE_INSTALL_PATH%\RefinitivWorkspace.exe" –rollback --silent; 

Uninstallation (uninstall.cmd) script example: 

@echo off 
:------ Identify the command's parameters to uninstall the software 
SET REFINITIV_WORKSPACE_INSTALL_PATH=C:\Program Files\Refinitiv\Refinitiv Workspace 
:: ----- Workspace Uninstallation ------ 
"%REFINITIV_WORKSPACE_INSTALL_PATH%\RefinitivWorkspace.exe" –uninstall --silent; 
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Appendix J: Workspace Messenger  
This appendix discusses the configuration of standalone and embedded Workspace Messenger for private line and private network 
connectivity. 

Standalone Messenger private line connectivity 
You can use Workspace Messenger to send and receive text messages, photos, and stock prices. 

Once you have installed Workspace Messenger, if you require connectivity through a Private Line, do the following: 

1. Navigate to the Refinitiv Workspace shortcut: 

a) Click Start  

b) Scroll to Refinitiv > Refinitiv Workspace 

c) Right-click Refinitiv Workspace and select More > Open file location 

2. In File Explorer, right-click the Refinitiv Workspace shortcut and select Properties 

3. Add the following parameters to the end of the Target field: 

--messenger-url=" https://collab.platform.refinitiv.biz/eikonmessenger" --connection=private  

Embedded Messenger private network connectivity 
To allow Workspace Messenger to route traffic through a private delivery network, you need to request that Workspace is 
permissioned for Messenger Private Delivery, using the following values: 

Product code 100464 

Permission Object name COLLRMPRIVATE 
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Appendix K: Unsupported packaging 
methods 
⚠ This section describes packaging methods that are neither recommended nor supported by LSEG. 

Supported methods  
LSEG supports the installation of Workspace, using the downloadable executable file:  

• On an individual basis. For further information, see the Basic Installation Guide. 

• Using a command line statement. See Installing Workspace, in this document. 

Unsupported methods  
Customers may choose to deploy Workspace using the methods summarized below. While we neither recommend nor, on an 
ongoing basis, support102 these approaches, the steps outlined below are understood to work. 

Packaging support 
Customers are entitled to a session of up to two hours of free packaging support, provided by one of our Technical Implementation 
Specialists (TIS). During this time, our specialist focuses on providing guidance and offers expert advice on packaging Workspace.  

Packaging support beyond this session will be chargeable. Should you require further assistance from LSEG, contact your 
Implementation Relationship Manager (IRM). 

Installing using an MSI installer 
You may choose to use the MSI installer method in situations where you are blocked from downloading and/or installing executable 
files, due to: 

• A policy that is enforced on your computer, for example, by an antivirus product, or  

• Your corporate firewall preventing access through their network 

To do this: 

1. Convert the RefinitivWorkspace-installer_x.xx.xx.exe file to an MSI 

installer. This can be done using tools such as MSI Wrapper or Advanced 
Installer.  

2. Open PowerShell103, with admin privileges, and navigate to the folder 
containing the .msi file.  

3. To install Workspace using the quiet install method, use the command104: 

Start-Process RefinitivWorkspace-installer_x.xx.xx.msi -ArgumentList "/quiet"  

A system test is performed and LSEG Workspace is installed. 

 
 
102  Refer to the Packaging support section. LSEG does not maintain test environments for these methods. 
103  For further information, refer to the online Microsoft PowerShell documentation. 
104  This command line instruction is used to install Workspace on one machine. For mass deployment, add the command to your deployment 

portal (Microsoft System Center Configuration Manager, for instance). 

https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/basic-installation-guide.pdf
https://www.exemsi.com/
https://www.advancedinstaller.com/
https://www.advancedinstaller.com/
https://learn.microsoft.com/en-us/powershell/scripting/overview?view=powershell-7.3
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Deploying using Microsoft Intune 
Using Microsoft Intune, you may be able to deploy Workspace to users in your organization.  

Pre-requisites 

The following are the pre-requisites for machines on which Microsoft Intune is used and applies to the machines to which 
Workspace is to be deployed.  

These requirements may not align with those of LSEG Workspace105:  

• Use Windows 10 version 1607 or later (Enterprise, Pro, or Education editions)106 

• Machines (or devices) to which Workspace is to be deployed must be enrolled in Intune, and one of the following107:  

• An Azure AD registered device 

• An Azure AD joined device 

• A hybrid Azure AD joined device 

• The installation file size must not be greater than 8GB. 

Deployment overview 

The Workspace installer file, RefinitivWorkspace-installer_x.xx.xx.exe, must be converted to a file with an .intunewin 

extension. The tool used to do this can be found on the Prepare Win32 app content for upload page. 

Creating the temporary folders 

1. Download the Content Prep Tool zip file and extract the tool (IntuneWinAppUtil.exe). 

2. In the Windows %temp% folder, create the following folders:  

• 1-LSEG_Workspace  
• 2-IntuneAppsLSEG_Workspace 108 

• 3-IntuneWinAppUtil  

3. In the LSEG_Workspace folder, add the following files:  

• RefinitivWorkspace-installer_x.xx.xx  
• install.cmd  
• uninstall.cmd  

Sample install.cmd script: 

START %temp%\1-LSEGWorkspace\RefinitivWorkspace-installer_x.xx.xxx.exe --user --silent --
installpath="%localappdata%\Refinitiv\Refinitiv Workspace" --
cachepath="%localappdata%\Refinitiv\Refinitiv Workspace\cachepath" --
installerlogpath="%localappdata%\Refinitiv\Refinitiv Workspace\installerlogpath" --
logpath="%localappdata%\Refinitiv\Refinitiv Workspace\logpath" --
shortcuts="%localappdata%\Refinitiv\Refinitiv Workspace\shortcuts" 

Sample uninstall.cmd script: 

START %temp%\1-LSEGWorkspace\RefinitivWorkspace-installer_1.22.303.exe --uninstall --silent 

4. In the 3-IntuneWinAppUtil folder, save the IntuneWinAppUtil.exe tool. 

Running the conversion tool 

Once the folders have been created, use the IntuneWinAppUtil.exe tool to create the Intune file. 

1. Open the 3-IntuneWinAppUtil folder and double-click the IntuneWinAppUtil.exe tool.  

2. At the Please specify the source folder prompt, type the path to the first temporary folder and press Enter.  

 
 
105  For further information, refer to the Workspace System Requirements. 
106  This requirement applies to all machines that are to be managed by Intune. 
107  For further information about Azure device categories, refer to the Concept section under Azure AD device identity documentation. 
108  The 2-IntuneAppsLSEG_Workspace folder acts as the repository for the converted installation file. 

https://learn.microsoft.com/en-us/mem/intune/apps/apps-win32-prepare#convert-the-win32-app-content
https://www.lseg.com/content/dam/data-analytics/en_us/documents/support/workspace/system-requirements.pdf
https://learn.microsoft.com/en-us/azure/active-directory/devices/
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For example:  

C:\temp\1-LSEG_Workspace  

3. At the Please specify the setup file prompt, type the name of the Workspace installation file and press Enter.  

For example: 

RefinitivWorkspace-installer-win32-x64_1.23.269.exe  

4. At the Please specify the output folder prompt, 
type the path to the second temporary folder and 
press Enter.  

For example:  

C:\temp\2-IntuneAppsLSEG_Workspace   

5. For the Do you want to specify catalog folder 
prompt, type N and press Enter. 

The conversion tool starts converting the installation 
file to .intunewin format. 

Installing through Intune 

Once the .intunewin file has been created in the 2-IntuneAppsLSEG_Workspace folder, follow the instructions in the Add, 

assign, and monitor a Win32 app in Microsoft Intune page. 

 Use the information in the following table as a reference when configuring Intune: 

Intune Name Mode Command 

Refinitiv Workspace - user 
mode 

--user RefinitivWorkspace-installer-win32-
x64_1.19.448.exe --user --silent 

Refinitiv Workspace - machine-
autoupdate-peruser mode 

--machine-autoupdate-peruser RefinitivWorkspace-installer-win32-
x64_1.19.448.exe --machine-autoupdate-peruser 

Refinitiv Workspace - machine-
autoupdate-service mode 

--machine-autoupdate-service RefinitivWorkspace-installer-win32-
x64_1.19.448.exe --machine-autoupdate-service 

Refinitiv Workspace - machine-
autoupdate-no mode 

--machine-autoupdate-no RefinitivWorkspace-installer-win32-
x64_1.19.448.exe --machine-autoupdate-no 

 

 

https://learn.microsoft.com/en-us/mem/intune/apps/apps-win32-add
https://learn.microsoft.com/en-us/mem/intune/apps/apps-win32-add
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Appendix L: Troubleshooting 

In this section 
• Microsoft Managed Desktop installation issue 

• Crash information uploads 

• JSON coding changes 

• Error codes 

• Logging 

• Networking issues 

• Using the Video Recorder tool 

• Using the Logs Viewer 

Microsoft Managed Desktop installation issue 
Customers who are doing the 
following, may encounter the error 
message, opposite, in their 
installation log file (under %temp%).:  

• Hosted on full Microsoft 
Managed Desktop (MMD) 
environments 

• Installing or uninstalling 
Workspace 1.22 or higher, and  

• Using a command line script  

This error stems from the introduction of sandboxed processes109 in Electron version 20, as a local policy or process is preventing 
Electron from executing the rendering process. This, in turn, prevents the Workspace installer from starting properly.  

Any workaround will need to be investigated and reviewed on a case-by-case basis. Contact LSEG Support who will investigate 
the issue further. Support will require your installer logs and information related to the installation. 

Crash information uploads  
If a crash occurs, Workspace sends the dump file to the internal Support 
platform.  

Whenever possible, Workspace also uploads session logs to provide more 
information to the support teams.  

Crash and log files are sent to the following internal Support platform:    

https:\\dst.platform.refinitiv.com\ 

JSON coding changes 
The following additional, advanced syntax changes have been made to the coding of JSON files: 

• Add single line comments, using // at the beginning of the line 

• Multiple line comments, using /* text text text */  

• Empty lines are permitted 

 
 
109  For further information, see Process Sandboxing | Electron. 

https://lsegroup-my.sharepoint.com/personal/duncan_keeling_lseg_com/Documents/TechDoc/W%20O%20R%20K%20S%20P%20A%20C%20E/E%20L%20E%20C%20T%20R%20O%20N/Workspace%20IT%20Managed%20Installation%20Guide/lseg-workspace-1.24-it-managed-installation-guide%20-%20124.03.docx#_Error_codes
https://dst.platform.refinitiv.com/
https://www.electronjs.org/docs/latest/tutorial/sandbox
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• Indentation errors are skipped and do not cause interruptions 

• The last line of the file is not required to end with a comma 

Error codes 
The following error codes may be reported during an installation failure: 

Error reported Code Summary 

UNSUPPORT_PLATFORM 100 Unsupported Platform. 

FAILED_TO_INSTALL 101 Failed to install Workspace 

FAILED_TO_COPY_FILES 102 Failed to copy files to %AppData%\Refinitiv 

CANNOT_GET_FOLDER_SIZE 103 Cannot get folder size for stamping to Add/Remove program 

FAILED_TO_INSTALL_ADD_REMOVE_PROGRAM 104 Failed to install Add/Remove program 

FAILED_TO_INSTALL_WINDOWS_REGISTRY 105 Failed to install Windows registry 

FAILED_TO_CONFIG_PRODUCT 107 Failed to create/update config product 

FAILED_PREREQUISITE_CHECK 108 Failed prerequisites check 

ALREADY_INSTALLED 109 Already installed 

NO_INSTALLATION_FOUND 110 No installation found 

FAILED_TO_UNINSTALL 201 Failed to uninstall 

FAILED_TO_UNINSTALL_CANNOT_REMOVE 202 
Failed during uninstall process. Cannot remove Refinitiv 
Workspace folder 

UNSUPPORT_PLATFORM 300 Unsupported operating system 

INVALID_COMMAND_ARGUMENT 301 Invalid parameter used in installation command line 110 

INVALID_ARGUMENT_VALUE 302 Invalid parameter used in installation command line  

CUSTOM_PATH_NOT_ALLOW 303 
Make sure that the path(s) entered in parameter(s) are compatible 
with the chosen installation mode 

ALREADY_INSTALL 310 Workspace is already installed 

ALREADY_INSTALL_DIFFERENT_MODE 311 
You cannot proceed with the installation, as Workspace is already 
installed with a different installation mode  

OFFICE_REGISTRY_CLI_NOT_SUPPORT 321 
You must update Workspace to version 1.21 or higher to use the -
-office-registry command 

UPDATE_OFFICE_REGISTRY_CLI_NOT_SUPPORT 322 
You must update Workspace to version 1.21 or higher to use the -
-update-office-registry command. 

UPDATE_BLOCKED_BY_OFFICE_REGISTRY 323 

Update is blocked because your office registry is set to HKCU. 
Reset using --update-office-registry=HKLM before 

performing the update again 

 
 
110  See Workspace Help parameter options. 
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Error reported Code Summary 

NOT_ALLOW_ROLLBACK_BY_OFFICE_REGISTRY 324 

Rollback is blocked because your office registry is set to HKCU. 
Reset using --update-office-registry=HKLM before 

performing the update again 

SYSTEM_CHECK_FAILED 350 The installer was unable to run the system test successfully 

SYSTEM_CHECK_UNKNOWN_RESULT 353 The installer was unable to run the system test successfully 

NOT_ENOUGH_DISKSPACE 351 Insufficient disk space on which to install Workspace 

NO_ADMIN_RIGHT 352 Workspace installation requires Administrator privileges 

FILE_IS_LOCKED 400 Process stopped as Workspace file(s) in use 

FILE_IS_MISSING 401 
Workspace installation executable does not contain all required 
files 

INSTALLER_FILE_CORRUPT 451 Workspace installation executable is corrupt 

NO_INSTALLATION_FOUND 500 Workspace installation file was not found 

MS_OFFICE_PROCESS_IS_RUNNING 501 Installation stopped as Microsoft Office applications are running 

FAILED_TO_HANDLE_FILE 801 Unable to access Workspace installation files 

FAILED_TO_CONFIG_PRODUCT 802 Unable to configure product 111 

FAILED_TO_ADD_REMOVE_PROGRAM 810 Unable to update Add/Remove Programs 

FAILED_TO_ADD_WINDOWS_REGISTRY 811 Unable to update Windows registry 

UNKNOWN_ERROR 999 Unknown error 

Logging  

Uploading Workspace logs 
You can upload Workspace logs by using: 

• A menu option   

• Excel launcher 

Menu option  

• From the Help menu, select Upload logs.  

 

 

 

 

 

 
 
111  In this event, contact Support. You will also be asked to provide your installation log file. 



 LSEG Workspace – Desktop Installation and Configuration Guide 

Appendix L: Troubleshooting 73 

Excel launcher 

If you are logged into Excel:  

6. Press Shift+Ctrl+Space. 

7. In the Search window, type 
/log. 

8. Click Upload Logs. 

 

 

 

Log upload workflow  
By user request or if a crash occurs, Workspace sends the contents of the 
application logs folder to the internal Support platform:  

https:\\dst.platform.refinitiv.com\ 

To save bandwidth, log uploads are sent in chunks of no more than 5Mb. 
Additionally, logs that have already been uploaded are not uploaded again.  

You can also upload log files to the desktop support site using the following 
command line: 

RefinitivWorkspace.exe --upload-logs 

Log upload troubleshooting 
For troubleshooting purposes, the settings112 shown in the table below can be written to the user-settings.json or machine-
settings.json file: 

Setting Purpose 

EIKON.LOGSUPLOAD.VERBOSEOUTPUT Set to true to have some output generated in the console. 

EIKON.LOGSUPLOAD.DEACTIVATEENCRYPTION Set to true to send the logs without encryption. 

EIKON.LOGSUPLOAD.WRITETEMPFILESONDISK Set to true to write the original and the crypted zips in the %TEMP% folder. 

EIKON.LOGSUPLOAD.TESTDECRYPTIONLOCALLY Set to true to test that decryption works locally (useful with VERBOSEOUTPUT 

and/or WRITETEMPFILESONDISK). 

 

Networking issues 
After installing Workspace, you have the option of using the web logger 
command to troubleshoot networking issues. To do this:  

• Use the command RefinitivWorkspace.exe --web-logger, or 

• Activate it using the Web Logger checkbox under Configuration 
Manager > Logs: 

To troubleshoot networking issues: 

1. Launch Workspace with the --web-logger parameter, using the Command Prompt, or through the Configuration Manager. 

2. Enter your credentials and login. 

3. Navigate to the log folder location.  

 
 
112  By default, all these settings are set to FALSE. 

https://dst.platform.refinitiv.com/
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4. Open the most recently created desktop log file (web-requests.log) 113. This file is created and available with all captured 

web calls from Workspace. 

Resetting Electron application data 
You can use the following parameters to delete application data – configuration files, caches, preferences, and settings – resetting 
Electron.  

Important: Close all Workspace applications before running these commands. 

To do this, depending on your requirements:  

• Run RefinitivWorkspace.exe with a parameter, or 

• Select a cache clearing function under Configuration Manager > Cache 

Depending on the option chosen, resetting the cache has the following effect: 

Configuration Manager 
function 

Parameter Effect 

Clear all cache --resetCache Resets the product cache of Workspace to its default state. 
That is, as it would be after a fresh installation. 

Clear Electron cache --resetElectronCache Reset the Electron cache of Workspace to its default state 

Using the Video Recorder tool 
The Video Recorder tool allows you to capture and save video footage of your entire 
desktop or a particular screen. This is particularly useful for capturing issues you are 
experiencing with your environment to provide additional information to Support. 

You can start the tool from the Help menu or by using a parameter.  

Starting the tool from the Help menu 
To do this: 

5. Open the Help menu by clicking the ? icon.  

6. Select Video Recorder from the menu. 

Starting the tool using a parameter 
Run Workspace with the --video-recorder parameter. This can be done either by:  

• adding the parameter to the application shortcut by editing its properties, or  

• using the appropriate command line statement: 

Windows "%LOCALAPPDATA%\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe" --video-recorder  

macOS "/Applications/Refinitiv Workspace.app/Contents/MacOS/RefinitivWorkspace" --args --
video-recorder  

 

 
 
113  When Workspace shuts down, it generates both the web-requests.log file and a HAR-based topology log file. 
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The following dialog is displayed: 

 

 

 

 

 

 
 

 

`Capturing a video 
To capture a video, do the following:  

1. Click Start. 

2. In the dialog that is displayed, choose 
whether to capture video of your whole 
desktop or of a specific screen.  
 
While the video is recording, a dialog is 
displayed which shows the current size of 
the video file, as it is recording.  

 
 
 
 
 

3. Once you have captured the content you require, click Stop. 

4. Then, in the main dialog, click Save.  

 

 

 

 

A Windows Explorer dialog is displayed, 
with the Downloads folder open, by default.  

 

5. Optionally, navigate to a different download 
folder.  

6. Click Save. 

7. Contact Support, who will guide you 
regarding the submission of this file. 

 

https://www.lseg.com/en/contact-us
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Using the Logs Viewer 
The Logs Viewer facility allows you to view a comprehensive and filterable list of log 
entries that were captured in the main and other files. 

You can start the facility from the Help menu or by using a parameter.  

Opening the facility from the Help menu 
To do this: 

1. Open the Help menu by clicking the ? icon.  

2. Select Logs Viewer from the menu. 

Opening the facility using a parameter 
Run Workspace with the --logs-viewer parameter. This can be done either by:  

• adding the parameter to the application shortcut by editing its properties, or  

• using the appropriate command line statement: 

Windows "%LOCALAPPDATA%\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe" --logs-viewer  

macOS "/Applications/Refinitiv Workspace.app/Contents/MacOS/RefinitivWorkspace" --args --logs-viewer  

Logs Viewer parameters 

The table below lists valid parameters for the --logs-viewer command line statement: 

Parameter Description 

--logs-viewer Select the main file, which is the log of the current Workspace session, in the current 
log folder 

--logs-viewer=* Select all files in the current log folder 

--logs-viewer=<prefix> Select the files in the log folder that have the defined <prefix>. Where <prefix> is one 
of the following: 

main – Workspace desktop log 

excel – Workspace for Excel log 

renderer – Workspace window rendering log 

node – Node.js log 

--logs-viewer=<file> Select the specified log file. For example: 

--log-viewer="%LOCALAPPDATA%\Refinitiv\Refinitiv Workspace 
Logs\Desktop.20230104.151635.p8956\renderer-1-
r6.20230104.p22728.log" 

--logs-viewer="<folder path>" Select the main log file from the specified <folder>. For example: 

--log-viewer="%LOCALAPPDATA%\Refinitiv\Refinitiv Workspace Logs" 

--logs-viewer="<folder path>\*" Select all files from the specified <folder>. For example: 

--log-viewer="%LOCALAPPDATA%\Refinitiv\Refinitiv Workspace Logs\*" 

--logs-viewer="<folder 
path>\<prefix>" 

Select files with the specified <prefix> from the specified <folder>. For example: 

--log-viewer="%LOCALAPPDATA%\Refinitiv\Refinitiv Workspace 
Logs\renderer" 

 



 LSEG Workspace – Desktop Installation and Configuration Guide 

Appendix L: Troubleshooting 77 

Overview of the Logs Viewer panel 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Importing files  
Under the Files filter, log files held in folders that are not listed in the 
Logs Viewer can be imported into the viewer. 

To do so: 

1. In Windows Explorer, open the folder containing the file(s) to 
import.  

2. Select the file(s). 

3. Drag the files into the Logs Viewer panel 114. 

When you release your pointing device, the files are added to the 
viewer under the folder in which they were located.  

 
 
114  You can copy the files into the existing folder by holding the Ctrl key before releasing your pointing device. 

Header – 
Containing file 

name and length 

Show dates as UTC – date and time is converted to 
UTC time zone. 

Show Dates as Local – Default. Date and time shown 
in local time zone. 

Auto-scroll – Updates to a single selected file are 
tracked and the new data is added. Select this to scroll 
automatically to the bottom when an update occurs. 

Log entry list, 
where the 
background color 
indicates the type 
of entry: 

     Error 

     Warn 

     Info 

     Debug 

     Verbose 

Tags are extracted from 
the log text when there is 
an info, error, warn, and 

so on, prefix 

Select from a list of all log 
files, then click GO to 

confirm your selections 

What – the type of 
file. That is, main, 

excel, renderer, 
and so on. 

Where – file name, 
if more than one of 
that type, and line 

number 

When – date and 
time stamp (local or 

UTC) 

Shift – time 
variance from first 

log entry 

Level – error, 
warning, info, 

debug, or verbose 

Tags – [XYZ] 
markers found in 

the log entry 

Textual search 
of all filtered log 

records 

The contents of the 
selected files are 

saved to a .csv file 
in 

%LOCALAPPDATA%\
Temp\Refinitiv 
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Using the Actions menu 
The Actions menu, an ellipsis found under the Actions column, can be used to copy the contents of specific log file entries.  

To open the Actions menu:  

1. Hover your cursor over the Actions column of the entry to copy. 

An ellipsis appears.  

2. Click the column to display the menu.  

3. Choose from the following options: 

 

  

Copy raw line Copy the original data from the log file to the 
clipboard. 

This copies the entire contents of the line, 
including date, time, and so on. 

Copy Text Column Copy the content of the Text column to the 
clipboard. 
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Appendix M: Known issues  
This appendix summarises any outstanding issues in Workspace, identifies the version(s) impacted, where appropriate, and 
provides workaround instructions, if known. 

In this section 
• Datastream for Office issues 

• DPRM connection issue 

• Excel add-in loading issues 

• Installing standalone Workspace Messenger 

• Contributions (RtContribute) 

• Virtualized environment issues 

• SSL inspection support 

Datastream for Office issues  
The following issues have been identified that would impact DFO users only: 

• When the Autorefresh parameter is set to Off in a DSGRID formula, the refresh of the formula may hang and will display 
Retrieving data indefinitely. 

• The copying and pasting of a DSGRID formula should use cached data but currently does not. 

• When the Compile option is selected in Excel, a VBA alert is displayed when opening a new Request table. 

• When cell referencing in the formula builder, the cell to return the formula is moved to the cell reference location, causing an 
error. 

DPRM connection issue115 
If DPRM-related settings are read incorrectly, it may result in DPRM failing. In this case, the No working server available 
for DPRM log file error message. 

As a workaround, the following settings should be added to your configuration file: 

{ 
"EIKON.STREAMING.API.__CORE__.PLUGINS.ADDITIONAL.LOCAL": "%.7%,%.8%", 
"EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.1": 
"%EIKON.STREAMING.API.LOCAL.DACS.DPRM.SERVERS%", 
"EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.2": 
"%EIKON.STREAMING.API.LOCAL.DACS.DPRM.PORT%", 
"EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.3": 
"%EIKON.STREAMING.API.LOCAL.DACS.USERNAME%", 
"EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.4": 
"%EIKON.STREAMING.API.LOCAL.DACS.FORCECASE%", 
"EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.5": "%USERDETAILS.UUID%", 
"EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.6": 
"%EIKON.STREAMING.API.LOCAL.DACS.DPRM.INTERVAL%" 
} 

 
 
115  The workaround is only required for installations of Workspace 1.23. Therefore, if you have upgraded, these settings will need to be removed. 
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Retrieving permissions 
If you use this workaround, the default for retrieving permissions from the LSEG Real-Time Advanced Distribution Server116, to 
which you are currently connected, will not work.  

As such, you need to specify a value for the following setting: 

EIKON.STREAMING.API.LOCAL.DACS.DPRM.SERVERS 

Limitations 
There are several impacts of these additional settings that are described below.  

Defining additional local connections 

If you use additional local connections, you will be limited to two. These are the connections configured using the following 
settings: 

EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.7  
EIKON.STREAMING.API.LOCAL.ADDITIONAL.SESSIONS.8  

Using Configuration Manager  

This workaround will severely impact use of Configuration Manager. 

Certain components of Configuration Manager – Streaming feeds, for instance – will not initialized properly. As such, any changes 
made in Configuration Manager will not persist and, therefore, will have no effect on Workspace. 

Excel add-in loading issues 

Trust Center policies 
If the Group and/or Microsoft 365 Trust Center policies are set to deny the use of Web add-ins, certain Workspace add-in menu 
ribbon items, such as Deals BI, may not load. 

To resolve this issue, do the following: 

1. Open a Microsoft 365 file (Word 
document, Excel spreadsheet, …)  

2. Open the File menu 

3. Select Options 

4. In the Options dialog, select Trust 
Center 

5. Click the Trust Center Settings… 
button 

6. Select Trusted Add-in Catalogs ❶ 

7. Uncheck the Don’t allow any web 
add-ins to start checkbox ❷ 

Workspace installations without automatic update117 
For users installing Workspace using –-machine-autoupdate-no, the Excel add-in does not load correctly on non-virtual 

machines. This is because the default location of the Office registry key is registered at HKLM. 

To correct the registry key location, use the command: 

<install path>\RefinitivWorkspace.exe --update-office-registry=HKCU 

 
 
116  For further information about configuring Real-Time data, refer to Appendix G: Configuring Real-Time Data products. 
117  PCN206237 provides more information about this fix. 

❶ ❷ 

https://my.refinitiv.com/content/mytr/en/product-notifications/details.html?id=PCN206237
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Contributions (RtContribute) 
The Refinitiv Workspace - Excel (Workspace ribbon) add-in was added in Workspace version 1.16. The following list summarizes 
the known issues and their solutions or when they are to be addressed. 

Issue Solution/To be addressed in 

LSEG Real-Time Advanced Distribution Server118 (formerly ADS) version 3.5.2 L1 
does not support the contribution from Workspace Excel. 

Install version 3.5.2 L3119 or higher. 

POS and LANGUAGE parameters are not supported. Requires sending data in 
RMTES encoding.  

Only UTF-8 is supported by the API 

LSEG Real-Time Advanced Distribution Server version issues 
Further issues concerning WebSocket connections were addressed in the 3.5.2 L3 release, together with minor changes to the 
default settings, which improved the handling of larger messages.  

Virtualized environment issues 
If you encounter an issue when running Workspace in a virtualized environment, LSEG requests that you confirm the issue has 
been reproduced in a non-virtualized environment. 

CVAD environments 
This section lists all known issues when running Workspace on a CVAD environment: 

Subject Jira  
reference 

XenApp  
pub. app 

XenApp  
pub. d’top 

Xen 
Desktop 

RTGet template which has 10k functions is not responding on 
applying "save as val- agreeues-Workbook" 

EFO-8412    

Refinitiv Workspace - Excel is not automatically sign in and 
retrieve the data when Open saved Functional template + 
native excel via command line 

EFO-8579 
 

Yes Yes 

HelpApi request doesn't work HELP-5828 Yes   

All menus are displayed as separate entry in taskbar SAP-9231 Yes 
  

Toast UI is displaying as separate entry in taskbar SAP-9233 Yes 
  

Notification Centre: Toast still appears when user activate 
Focus Assist on local machine 

SAP-9617 Yes 
  

There is a small black area around toasts SAP-9620 Yes 
  

Shortcut (ALT + S) doesn't work SAP-10009 
  

Yes 

RW in XenApp does not support custom protocols SAP-10157 Yes   

Black areas are shown near guidelines and snapping lines SAP-10399 Yes 
  

Snapping/grouping features breaks after moving a tile 
(moving frame) 

SAP-10368 Yes 
  

 
 
118  For further information about configuring Real-Time data, refer to Appendix G: Configuring Real-Time Data products. 
119  See also Creating an internal connection.  
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Subject Jira  
reference 

XenApp  
pub. app 

XenApp  
pub. d’top 

Xen 
Desktop 

Black screen is displayed around opened window for area 
and full screen screenshot 

SAP-10785 Yes   

Messenger on Citrix XenApp environment intermittently 
freeze while typing in the text box 

SAP-11267 Yes   

File type is not added into save dialogue SAP-14187    

Unknown container type and app-name into UsTracking evet 
for Tile, Modal window 

SAP-18302    

If the 'Position of Toast' sets as 'Bottom - Right or Left', it's not 
working as expected 

SAP-24424 Yes   

Three horizontal dots (ellipsis) option is not appearing in the 
toast notification 

SAP-24438 Yes   

Not able to close the popped-out conversation in the system 
task bar 

SAP-24439 Yes   

Deep links are not opened on virtual desktop machines SAP-25517    

[Widely:] Palo Alto Networks TS Agent can raise problems - 
whitelisting 

---    

 

VMware environments 
This section lists all known issues for running Workspace on a VMware Horizon 8 environment: 

Subject Jira reference Horizon virtual 
apps 

There's only 'Close window' in the task bar SAP-10823 Yes 

Published Apps - Do not disturb option is activated on Published Apps when 
Focus assist is OFF in OS settings 

SAP-10972 Yes 

Published Apps - Impossible to copy screenshot to clipboard for Virtual App SAP-11011 Yes 

Tiles - Snapping line and guideline are visible only after dropping a tile SAP-11025 Yes 

Tiles - Group movement is not working properly SAP -11026 Yes 

Tiles - Single tile resizing works for snapped or grouped tiles SAP-11027 Yes 

Impossible to open deep link SAP-11955 Yes 

Published Apps - RW desktop 1.19 is not resized SAP-22571 Yes 

Tiles - Pinned tile manager can be moved SAP-22620 Yes 

 

SSL inspection support 
LSEG does not support or enforce SSL inspection, sometimes referred to as TLS/HTTPS Interception. 

If clients use SSL inspection, they must configure URL filtering profiles not to enforce SSL inspection on LSEG domains, such as 
*.refinitiv.com, *.refinitiv.net, *.refinitiv.biz. 
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Cache path definition 
An alternative cache path can be defined for Workspace during its installation, using the parameter:  

RefinitivWorkspace-installer_x.xx.xx.exe --cachepath=”<folder_path>”  

However, currently, this does not re-route the entire content of the Refinitiv Workspace folder in the cache. That is, while the 

electron folder is moved to the new location, the following subfolders are not:  

• Config 

• Dictionaries 

• Data API Proxy 

• File Links 

Signing in automatically 
When users first log into Workspace, they have the option of choosing to sign in automatically in 
future, which creates a cookie in the electron cache for the user. 

However, if electron is upgraded to a higher version, the cache is cleared, and users are expected to 
sign in again. 

 As this may occur many months later, users may have lost their credentials. 

Rolling back 
The following Rollback command allows you to revert to the automatically installed version of 
Workspace application that is immediately prior to your current version: 

"<Install Path>\Refinitiv\Refinitiv Workspace\RefinitivWorkspace.exe" –rollback 

However, following a rollback, the version from which rollback was performed can no longer be updated automatically. 

For example: 

1. You install Workspace version 1.24.163. 

2. Workspace updates automatically to version 1.25.180. 

3. Using the rollback command, you revert to version 1.24.163. 

As a result, version 1.25.180 is flagged120 and can no longer be updated automatically. 

4. When a new version is released – for example, version 1.25.198 – Workspace updates automatically to the new version. 

Rolling forward command support 
Due to changes to the Workspace architecture, the --rollforward command line parameter is only valid for version 1.19 or 

higher. Also, this command can only be used after a --rollback operation has been performed.  

 

 
 
120  Version flagging is done using a machine-specific VersionControl.json file to record that a rollback has been performed on the respective 

machine and to block an automatic update to the rolled-back version. 
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Appendix N: Glossary 
This appendix is divided into two sections, providing: 

• A list of acronyms. 

• Description of Workspace-related terminology. 

 This appendix is a work in progress and will be expanded upon in future releases. Should you encounter acronyms or terms 
that you would like added to this section, you can reach us through the docfeedback@lseg.com channel. 

Acronyms 
The following acronyms are used throughout this document: 

Acronym Definition 

ADH Advanced Distribution Hub (see rebranded term) 

ADS Advanced Distribution Server (see rebranded term) 

AMERS Americas region 

APAC Asia-Pacific region 

API Application Programming Interface 

ARP Add/Remove Programs (registry entries) 

ATS Advanced Transformation Server (see rebranded term) 

AWS Amazon Web Services 

CMC Customer Managed Connectivity (see term) 

CPU Central Processing Unit 

CVAD Citrix Virtual Apps and Desktops 

DACS Data Access Control System (see rebranded term) 

DFO Datastream for Office 

DLL Dynamic Link Library 

DNS Domain Name Service (see term) 

DPRM Data Protection and Risk Mitigation 

ECCN Export Control Classification Number 

EMEA Europe, Middle East, and Africa region 

FCN Financial Community Network (see term) 

FIPS Federal Information Processing Standards 

FQDN Fully Qualified Domain Name 

GPU Graphics Processing Unit 

GUID Globally Unique Identifier 

HMDS Hosted Market Data System 

mailto:docfeedback@lseg.com
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Acronym Definition 

HTTP Hyper Text Transfer Protocol (see term) 

HTTPS Hyper Text Transfer Protocol Secure (see term) 

IDN Integrated Data Network 

IP Internet Protocol (see term) 

IRM Implementation Relationship Manager 

JSON JavaScript Object Notation 

LAN Local Area Network 

LSEG London Stock Exchange Group 

MMD Microsoft Managed Desktop 

MSI Microsoft Software Installer 

NTLM NT LAN Manager (see proxy authentication) 

OS Operating System 

PCN Product Change Notification 

PLI  Product Line Item 

PVS (Citrix) Provisioning Services 

RDP Refinitiv Data Platform (see rebranded term) 

RHEL Red Hat Enterprise Linux 

RIC Refinitiv Instrument Code (see term) 

RSSL Reuters Source Sink Library (see term) 

RTC Real-Time Connector 

RWF Refinitiv Wire Format (see term) 

SDK Software Development Kit 

SSL Secure Socket Layer (see term) 

SSO Secure Sign On 

TCP Transmission Control Protocol 

TIS Technical Implementation Specialist 

TLS Transport Layer Security (see term) 

TREP Thomson Reuters Enterprise Platform (see rebranded term) 

URL Universal Resource Locator (see term) 

UTC Coordinated Universal Time 

UUID Unique User Identifier 

VBA Visual Basic for Applications 
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Acronym Definition 

VDI Virtual Desktop Infrastructure 

VSTO Visual Studio Tools for Office (see term) 

WS • Workspace, in menu icon form, or  

• WebSocket (see term). 

WSS WebSocket Secure 

 

Terminology 
The following terms are used in this document, focusing primarily on those that are LSEG and Workspace-specific: 

Term Description 

Common Platform Provides the central services for Trading, Research, and Asset Management 
products, allowing services to be offered in a more consistent manner to our 
customers. 

Conflation rate The frequency with which data is updated. For example, in Workspace, a conflation 
rate setting of 3000ms would result in displayed data updating every three (3) 
seconds.  

Contributions Channel Allows data to be contributed to a Real-Time Advanced Distribution Server or LSEG 
directly. This data can then be consumed across Workspace products. 

Customer Managed Connectivity Enables customers to provide their own access circuit or cross-connect to the CMC 
access ports presented in Delivery Direct N-POPs which are located in key financial 
centres globally. 

Delivery Direct A customer connectivity service that uses high performance network capacity to 
deliver Refinitiv products and services to customers. 

Delivery Platform A unified open platform that allows clients to integrate the great depth and breadth of 
LSEG's data into their workflows. The platform delivers streaming and non-streaming 
content, across content sets, such as tick history, real-time pricing, reference, 
fundamentals, news, and so on.  

Formerly known as Refinitiv Data Platform (RDP). 

Desktop Deployment Portal A feature that allows an IRM or client to control the distribution of Workspace 
desktop packages. It can be used to verify and troubleshoot issues related to the 
automatic updating of Workspace Desktop. 

Digital signature An electronic stamp that is used to validate the integrity and authenticity of digital 
material, such as executables and dynamic link library files. 

Domain Name Service Technology that translates Internet domain names that are meaningful to users into 
IP addresses, which are usable by computers. 

Electron Electron is the underlying container on which LSEG Workspace is based. It is a 
framework for building desktop applications using JavaScript, HTML, and CSS. By 
embedding Chromium and Node.js into its binary.  

For further information, see What is Electron? 

Failover The capability to switch automatically to a reliable backup system. 

For Workspace, if it fails to connect to the first Real-Time Advanced Distribution 
Server connection, it attempts to connect to the next configured connection, if 
available. If none of these server connection attempts are successful, Workspace 
attempts to connect to LSEG hosted servers. 

https://www.electronjs.org/docs/latest/
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Term Description 

Financial Community Network A data network that operates separately from the public internet, for financial 
services operators such as investors, banks, and currency exchanges. 

Fully Qualified Domain Name A domain name that specifies its exact location in the tree hierarchy of the Domain 
Name System. It specifies all domain levels, in hostname.domain.TLD format, where 
TLD is the top-level domain. 

HTTP persistent connection Rather than opening a new connection for each request/response pair, HTTP 
persistent connections use the same TCP connection to send and receive multiple 
HTTP requests and responses. Indeed, the HTTP/2 protocol takes this a stage 
further and allows multiple concurrent request/response pairs to be multiplexed over 
a single connection. 

Hypertext Transfer Protocol The data processing rules for transferring files, such as text, graphic images, sound, 
video, and other content on the Web. 

Hypertext Transfer Protocol Secure A set of procedures used by Web servers and Web browsers to encrypt content 
before it is sent across the Internet. 

Internet Protocol A set of rules that defines how data should be delivered over the public Internet. 
Often referred to alongside the Transmission Control Protocol (TCP). 

Keep alive connection See HTTP persistent connection. 

Load balancing Distributing users equally across multiple active servers.  

In the Workspace configuration file, this is activated using a LOADBALANCING 
setting. 

Local Area Network A collection of devices connected together in one physical location. Generally, they 
are structured in one of two ways:  

• client/server  

• peer-to-peer 

Log Viewer A facility, called from the Workspace Help menu, that allows you to view a 
comprehensive and filterable list of log entries that were captured in the main and 
other files. 

LSEG Workspace A cross-platform solution - on desktop, Web, and mobile - that gives you access to 
the broadest and deepest coverage of financial data, news, analytics and 
productivity tools in a highly customized experience. 

Permission Synchronisation Connects a customer’s local deployed Real-Time Data Access Control System 
directly to the LSEG Workspace infrastructure. Any changes made to DACS 
permissions are not only pushed out to the local Real-Time Distribution System but 
also uploaded simultaneously to the Workspace infrastructure. 

Also referred to as Perm Sync. 

Provisioning Services A streaming technology, offered by Citrix, that delivers software patches, updates, 
and other configuration data to multiple virtual desktops through a single, shared 
desktop image. 

Proxy authentication Enables the configuration of the authentication method used by the proxy, which 
determine how client machines are validated when accessing the Internet. For a list 
of the methods for which Workspace is qualified, see Qualified Proxy. 

Real-Time Advanced Distribution Hub The horizontally scalable service component within Real-Time Distribution System, 
providing high availability for publication and contribution messaging, subscription 
management with optional persistence, conflation and delay capabilities.  

Formerly known as ADH. 
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Term Description 

Real-Time Advanced Distribution Server The component of the Real-Time Distribution System that distributes data and 
updates to consuming applications.  

Formerly known as ADS. 

Real-Time Advanced Transformation 
Server 

A multifunctional server that brings real-time data together from multiple sources, 
allowing users to create synthetic records and models that define custom 
calculations, rules, and logic. Real-Time Advanced Transformation Server 
transforms, calculates, and publishes resulting data onto the platform for further 
distribution and consumption.  

Formerly known as ATS. 

Real-time Connector Provides a consolidated point-to-point fan-out distribution solution for LSEG, value-
added, third-party data for trading room systems and cloud deployments. Real-Time 
Connector distributes data using proprietary LSEG protocols built on top of TCP/IP. 
Real-Time Connector also supports distributing data in JSON over WebSocket 
connections. 

Real-Time Data Access Control System A set of tools for managing access to services and data for Real-Time Distribution 
System customers. It controls user access to data consuming and publishing 
applications, including content from LSEG, third parties, or proprietary feeds. 

Formerly known as DACS. 

Real-Time Distribution System A distribution architecture that controls the flow of real-time data to display and 
analytical applications, for use by humans or machines.  

Formerly known as TREP. 

Real-Time Managed Distribution Service Enables customers to access cloud-based capabilities for market data integration, 
distribution, publication, analytics and more. LSEG operates and oversees all the 
equipment, feeds, platforms and connectivity that a firm might need, with 23 globally 
distributed Points of Presence. 

Refinitiv Instrument Code A market-level identifier for instruments and pricing sources, issued by LSEG. 

Refinitiv Wire Format RWF is a binary protocol, almost identical to the RSSL protocol used in Eikon 4.0. 
The key difference between the two protocols is that RWF is carried over a 
WebSocket connection, while RSSL uses a raw TCP/IP connection. 

Reuters Source Sink Library A suite of software components for applications that distribute real-time data from 
multiple sources. 

Roll back Reverting to the automatically installed version of LSEG Workspace that was 
installed prior to your current version. 

Roll forward Allows you to return to the version of LSEG Workspace from which you rolled back 
(see above). 

Secure Socket Layer An encryption technology for making a secure link between a server and a client, 
such as a web server and a browser. 

tconfig utility Used to extract configuration parameters from the component parameter definition 
(component.cpd) files, present them to the administrator to assign site and/or 
component specific values, and integrate them into a temporary copy of the 
configuration database. 

Transmission Control Protocol A set of rules, used alongside the Internet Protocol, to make sure data packets are 
delivered reliably. It includes mechanisms to deal with packets that are lost, in the 
wrong order, duplicated, or corrupted. 

Transport Layer Security A cryptographic protocol that provides privacy and data security for information sent 
between applications over the Internet. 
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Term Description 

Universal Resource Locator Commonly thought of as a Web address. Technically, it specifies a protocol, such as 
HTTP, a domain name or IP address, and additional path information. 

User Agent An application that retrieves and presents Web content for users or is implemented 
using Web technologies. 

Visual Studio Tools for Office A Visual Studio add-in and a runtime that allows Microsoft Office (2003 or higher) 
applications to run through .NET. 

WebSocket WebSocket is a standard communication protocol built on top of TCP connection. 
The WebSocket protocol enables streams of messages between Real-Time 
Advanced Distribution Server and WebSocket-based client applications over the 
Internet. It also allows Real-Time Advanced Distribution Server to communicate with 
WebSocket-based client applications, regardless of platforms and programming 
languages. 

Wide Area Network In its simplest form, a collection of local-area networks (LANs), or other networks that 
communicate with each other. Essentially, it is a network of networks. 
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Version History 
Workspace Document Summary 

1.26/1.26.1 1261.01 The document was moved into the new common template and, following user feedback, changes were made 
throughout the guide, including: 

• New Appendix M: Glossary 

• Expanded Desktop executable parameters section 

• New Installer parameters section 

• Updated and moved Mass deployment section 

1.25/1.25.1 125.08 • Correction to the script example in the Connections secured with certificates section. 

 125.07 • Correction to the Messenger parameter. 

 125.06 • Updated the Rolling back section, to clarify the impact.  

 125.05 • Additional information added for RWupdater service. 

• Fixed link in footnotes. 

• Footnote added regarding potential PowerShell issue. 

 125.04 • Updated the Private Network link in the Download locations section. 

 125.03 • Updated the Content filtering domains section to include pi.refinitiv.com in the whitelisting list. 

 125.02 • Updated the trusted root certification section  

 125.01 • New appendix covering Real-Time Data configuration requirements 

1.24/1.24.1 124.08 • Fixed minor internal linking issues 

• Fixed incorrect use of backslash in Workspace Messenger section 
 

124.07 • Update to the Troubleshooting appendix regarding the MMD installation issue 

• Minor update to Protocol support 

• Renaming RDP to Delivery Platform (corporate rebranding) 

• Updated Server software > Versions section 

 124.06 • Table rendering issues 

• Internal document links 

 124.05 • Further clarification of Protocol support 
 

124.04 • Minor change to Streaming protocols 

• Minor change to Protocol support 

 124.03 • A minor change to the Configuring multiple servers section. 

• A known issue affecting Datastream for Office (DFO) users only. 

 124.02 • Updating links to point to new LSEG site. 

 124.01 • New digital certificates 

• The DPRM connection issue, affecting Workspace 1.23 only, has been fixed. 

1.23 123.03 • Added Appendix K: Unsupported packaging methods. 

 123.02 • Updated Appendix M: Known issues to include DPRM connection issue. 

 123.01 • Guide rebranded for initial LSEG Workspace pre-release. 

• Additional features added to the Configuration Manager 
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